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Overview

Intended Readers
This guide is intended for use by qualified personnel in charge of setting up and starting

NovaScale 6080/6160/6320 Servers for the first time.

Chapter  1. Delivery
describes server features and explains delivery unpacking and inspection procedures.

Chapter 2. Setup Procedure
explains the procedures required to set up and start the server for the first time.

Chapter 3. Troubleshooting
explains what to do if a problem occurs during installation.

Appendix A. Specifications

Appendix B. Conversion Tables

Appendix C. Server Cabling

Highlighting
The following highlighting conventions are used in this guide:

Bold Identifies predefined commands, subroutines, keywords, files,
structures, buttons, labels, and icons.

Italics Identifies referenced publications, chapters, sections, figures,
and tables.

<         > Identifies parameters to be supplied by the user.
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Related Publications
Site Preparation Guide, 86 A1 87EF 
explains how to prepare a Data Processing Center for Bull NovaScale Servers, in
compliance with the standards in force. This guide is intended for use by all personnel
and trade representatives involved in the site preparation process.

User’s Guide, 86 A1 21EM
explains how to use NovaScale 6080/6160/6320 Servers. This guide is intended for use
by Customer Administrators and Operators.

Maintenance and Service Guide, 86 A7 26EM
explains how to maintain, service, and upgrade NovaScale 6080/6160/6320 Servers.
This guide is intended for use by qualified support personnel.

Troubleshooting Guide, 86 A7 91EF
explains how to diagnose and solve any problems occurring during Bull NovaScale
Server operation. This guide is intended for use by qualified support personnel.

Documentation Overview, 86 A2 27EM
describes the hardware, software and online documentation available for Bull NovaScale
Servers, related Operating Systems, and licensed programs.

Bull 40U/19U Server Rack Cabinets, 86 A1 91EM
explains how to install and fit out rack cabinets for Bull NovaScale Servers and peripheral
devices.

 Note:
According to server configuration and version, certain features and functions described in
this guide may not be accessible. Please contact your Bull Sales Representative for sales
information.
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Regulatory Specifications and Disclaimers

Declaration of the Manufacturer or Importer
We hereby certify that this product is in compliance with European Union EMC Directive
89/336/EEC, using standards EN55022 (Class A) and EN55024 and Low Voltage Directive
73/23/EEC, using standard EN60950. The product has been marked with the CE Mark to
illustrate its compliance.

Safety Compliance Statement
• UL 60950 (USA)
• IEC 60950 (International)
• CSA 60950 (Canada)

European Community (EC) Council Directives
This product is in conformity with the protection requirements of the following EC Council
Directives:

Electromagnetic Compatibility

• 89/336/EEC

Low Voltage

• 73/23/EEC

EC Conformity

• 93/68/EEC

Telecommunications Terminal Equipment

• 199/5/EC

Neither the provider nor the manufacturer can accept responsibility for any failure to satisfy
the protection requirements resulting from a non-recommended modification of the product.

Compliance with these directives requires:

• an EC declaration of conformity from the manufacturer

• an EC label on the product

• technical documentation
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Federal Communications Commission (FCC) Statement

 Note:
This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC
emission limits. Neither the provider nor the manufacturer are responsible for any radio or
television interference caused by using other than recommended cables and connectors or
by unauthorized changes or modifications to this equipment. Unauthorized changes or
modifications could void the user’s authority to operate the equipment.

Any changes or modifications not expressly approved by the grantee of this device could
void the user’s authority to operate the equipment. The customer is responsible for ensuring
compliance of the modified product.

FCC Declaration of Conformity
This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Canadian Compliance Statement (Industry Canada)
This Class A digital apparatus meets all requirements of the Canadian Interference Causing
Equipment Regulations.

Cet appareil numérique de la classe A est conforme à la norme NMB–003 du Canada.

This product is in conformity with the protection requirements of the following standards:

Electromagnetic Compatibility

• ICES–003
• NMB–003

Laser Compliance Notice
This product that uses laser technology complies with Class 1 laser requirements.

A CLASS 1 LASER PRODUCT label is located on the laser device.

Class 1 Laser Product

Luokan 1 Laserlaite

Klasse 1 Laser Apparat

Laser Klasse 1
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Definition of Safety Notices

 DANGER
A Danger notice indicates the presence of a hazard that has the potential of causing
death or serious personal injury.

 CAUTION:
A Caution notice indicates the presence of a hazard that has the potential of causing
moderate or minor personal injury.

 Warning: 
A Warning notice indicates an action that could cause damage to a program, device,
system, or data.

Electrical Safety
The following safety instructions shall be observed when connecting or disconnecting
devices to the system.

 DANGER
The Customer is responsible for ensuring that the AC electricity supply is compliant
with national and local recommendations, regulations, standards and codes of
practice.
An incorrectly wired and grounded electrical outlet may place hazardous voltage on
metal parts of the system or the devices that attach to the system and result in an
electrical shock.
It is mandatory to remove power cables from electrical outlets before relocating the
system.

 CAUTION:
This unit has more than one power supply cable. Follow procedures for removal of
power from the system when directed.
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Laser Safety Information
The optical drive in this system unit is classified as a Class 1 level Laser product. The
optical drive has a label that identifies its classification.

The optical drive in this system unit is certified in the U.S. to conform to the requirements of
the Department of Health and Human Services 21 Code of Federal Regulations (DHHS 21
CFR) Subchapter J for Class 1 laser products. Elsewhere, the drive is certified to conform to
the requirements of the International Electrotechnical Commission (IEC) 60825–1: 2001 and
CENELEC EN 60825–1: 1994 for Class 1 laser products.

 CAUTION:
Invisible laser radiation when open. Do not stare into beam or view directly with
optical instruments.

Class 1 Laser products are not considered to be hazardous. The optical drive contains
internally a Class 3B gallium–arsenide laser that is nominally 30 milliwatts at 830
nanometers. The design incorporates a combination of enclosures, electronics, and
redundant interlocks such that there is no exposure to laser radiation above a Class 1 level
during normal operation, user maintenance, or servicing conditions.

Data Integrity and Verification

 Warning: 
Bull NovaScale Servers are designed to reduce the risk of undetected data corruption
or loss. However, if unplanned outages or system failures occur, users are strongly
advised to check the accuracy of the operations performed and the data saved or
transmitted by the system at the time of outage or failure.
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Environmental Standards

Climatic and Atmospheric Specifications
Bull NovaScale Servers comply with standards:

• IEC 60068.2.1

• IEC 60068.2.2

• IEC 60068.2.78

• IEC 60529

• IEC 60950

• ISO 7779

Electrical Specifications
Bull NovaScale Servers comply with standards:

• IEC 60038

• IEC 60059

• IEC 60196

• IEC 60364

• IEC 61689

Mains Source Power

• 207–244 VAC, 49 – 61 Hz (single phase Ph / N + PE or Ph / Ph + PE), 20A

Voltage Sag

• 20 ms (IEC 1000–4–11)

Electromagnetic Compatibility
Bull NovaScale Servers comply with standards:

Europe

• EN 55022 Class A

• EN 55024 Class A

• EN 61000–3–2

• EN 61000–3–3

North America

• FCC Part 15 Class A

• ICES–003 Issue 3 Class A

Protection against Electrostatic Discharges
CMOS (Complementary Metal Oxide Semiconductor) technology is highly sensitive to
electrostatic discharges. The use of conductive antistatic flooring is strongly recommended.

Maintenance personnel must wear wrist–straps before handling electronic equipment.
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Shocks and Vibrations
Bull NovaScale Servers comply with standards:

• IEC 60068–1

• IEC 60068–2–6

• IEC 60068–2–27

• IEC 60068–2–31

• IEC 60068–2–47

• IEC 60068–2–64

• IEC 60050

• ISO 2041

• ISO 5348

• ISO 5344

• ISO 8626

Operating Mode (on levelers)

• Sinusoidal vibrations:

– Duration: 1 sweep, 1 octave/mn

– 5 – 16 Hz range: 0.25 mm peak

– 16 –200 Hz range: 0.25 g peak

• Random excitation:

– Duration: 15 mn

– Frequency: 5 – 200 Hz

– Spectral density: 1.5x10–4 g�/Hz

– Root mean square acceleration: 0.17g RMS

Non–operating Mode (on castors)

• Sweep sine:

– Duration: 1 sweep, 1 octave/mn

– 5 – 16 Hz range: 0.25 mm peak

– 16 – 200 Hz range: 0.25 g peak

• Random excitation:

– Duration: 15 mn

– Frequency: 5 – 200 Hz

– Spectral density: 1.5x10–3 g�/Hz

– Root mean square acceleration: 0.54g RMS

Shock Tests:

• Duration: 11 ms

• Form: 1/2 sinusoidal

• Amplitude: 15 g
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Pollution Limits
Bull NovaScale Servers comply with standard:

• NFX44–101, Class 4 000 000

Audio–Noise Limits
Bull NovaScale Servers comply with standards:

• ISO 7779

• ISO 11201

• ISO 7574

• ISO 4871

• ISO 9295

• ISO 9296

• IEC 61260

• IEC 60651

Operating LwAd Acoustical Power

• 7.4 Bel

Operating Lpa Acoustical Pressure

• 60 dBA

Safety Specifications
Bull NovaScale Servers comply with national and international standards:

• IEC 60950

• EN 60950

• UL 60950

• CAN/CSA C22–2 N° 60950–00
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Installation Flowchart
This flowchart summarizes main installation and setup procedures.

Unpacking the Server

Step OK

• Inspect server packing

• Remove server packing

• Inspect the server

• Remove doors and side covers

• Unload the server cabinet(s) and accessories

• Store packing items

Installing and Securing the Cabinet

Step OK

• Position the cabinet(s)

• Secure the cabinet(s) into place

• Remove shipping brackets

Inspecting the Server

Step OK

• Check that the server is not damaged and is compliant with the Purchase Order

• Inspect internal components and cabling

• Refit doors and side covers
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Connecting Inter–Cabinet Cables

Step OK

• Connect server inter–cabinet data cables.

Connecting the Server to the Power Supply

Step OK

• Mount power supply cable sockets

• Connect the server power cables to the dedicated power supply

Powering up the Server

Step OK

• Power on the server to the standby mode

• Launch PAM software

• Check server status

• Power up / down the server domain(s)

• Shut down / restart the server

Completing PAP Unit Configuration and Operating System Setup

Step OK

• Change the PAP unit default name

• Launch the PAP Configuration Setup wizard

• Configure Customer information

• Configure Autocalls

• Connect the PAP unit to the Enterprise LAN

• Complete Operating System setup for the server domain(s)
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Connecting the Server to the Enterprise LAN and Connecting External Devices

Step OK

• Connect the server to the Enterprise LAN

• Connect external peripherals (storage, modem, ...)

Confirming Correct Installation

Step OK

• Test network connections

• Test Autocalls

• Record site data

• Send the Intervention Report
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Chapter 1. Delivery

This chapter explains delivery unpacking and inspection procedures for NovaScale

6080/6160/6320 Servers. It includes the following topics:

• Overview, on page 1-2

• General Recommendations, on page 1-7

• Unpacking the 36U Cabinet, on page 1-8

• Inspecting the Server, on page 1-11

• Unloading the 36U Cabinet, on page 1-12

• Installing and Securing the 36U Cabinet, on page 1-19

• Inspecting Internal Components and Cabling, on page 1-23

• Getting to know the Server, on page 1-27
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Bull NovaScale Server Overview
Bull NovaScale Servers for business and scientific applications are based upon the FAME
architecture (Flexible Architecture for Multiple Environments), leveraging the latest
generation of Intel� Itanium� 2 processors.

NovaScale 6xx0 Servers are designed to operate as one, two, three or four
hardware–independent SMP systems or domains, each running an Operating System
instance and a specific set of applications.

According to version, servers are delivered rack–mounted and ready–to–use in high or low
cabinets.

Figure 1. Bull NovaScale Server cabinets

Dynamic Partitioning
Bull NovaScale 6000 Series servers can be dynamically partitioned into physically
independent ccNUMA (Cache Coherent Non Uniform Memory Access) SMP systems or
domains, each running an Operating System instance and a specific set of applications.

Extended Configurations
Several Bull NovaScale Servers may be administered through a single instance of PAM
software.

Cluster Configurations
Several Bull NovaScale Servers may be grouped to act like a single system, enabling high
availability, load balancing and parallel processing.
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Server Features
The main features of Bull NovaScale Servers are:

Intel� Itanium� Processor Family architecture:

– Modularity, predictable performance and growth

High availability:

– Component redundancy

– Capacity to isolate or replace a faulty components without service disruption

– Global and unified system visibility

– Round–the–clock operation

Scalability:

– Dynamic partitioning

– Power on demand : capacity to dynamically adapt resources to load requirement

Simultaneous support of multiple environments:

– Microsoft� Windows� Server

– Linux�

High performance computing capabilites:

– Business Intelligence:

. Datawarehousing

. Datamining

– Large enterprise applications:

. ERP

. CRM

. SCM ...

– Large database applications for Internet transactions.

– Large business sector applications:

. Online billing

. Online reservations

. Online banking ...

Built–in Platform Administration and Maintenance (PAM) software suite:

– Proactive administration

– Optimization of resources

– Automatic generation of corrective actions and calls to support centers

– Dynamic configuration

Bull NovaScale Master System Management (NSM) software suite:

– Windows, Linux, and Platform management

– Monitoring, Information, Control, and Event Handling

– Client / Server / Agent architecture

– WEB standard OpenSource solutions
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Server Hardware

 Note:
Abbreviations and acronyms are documented in the Glossary.

Main server hardware components are:

Central SubSystem Module (CSS Module)
The CSS Module houses core hardware components:

• 2 or 4 QBBs

• 2 IOBs

• 2 IORs

• 1 PMB

• 1 MPB

• DPS units

A CSS Module can be logically divided into two Cells, each with one or two QBBs and one
IOB, to allow dynamic partitioning.

The NovaScale 6320 Server is equipped with two inter–connected CSS modules.

Quad Brick Block (QBB)

The QBB is equipped with 1 to 4 Itanium[  2 processors and 16 DDR DIMMs. The QBB
communicates with the rest of the system the high–speed bidirectional link Scalability Port
Switches (SPS) located on the Midplane.

IO Board (IOB)

The IOB provides 4 PCI–X bridges for the connection of up to 11 PCI–X boards, and a PCI
Hot Plug Board (PHPB). The IOB communicates with the rest of the system through the
high–speed bidirectional link Scalability Port Switches (SPS) located on the Midplane.

IO Riser (IOR)

The IOR is an IOB daughter board providing legacy IO connections: 2 USB ports, 1 LAN
port, 2 serial ports, 1 video port, and 1 CD/DVD Rom drive.

Platform Maintenance Board (PMB)

The PMB concentrates logistics access and links the platform to the Platform Administration
Processor (PAP Unit) running Platform Administration and Maintenance (PAM) software.

Midplane (MPB)

The MPB houses the high–speed directional link Scalability Port Switch (SPS). The MPB
is divided into two physical Cells, each capable of connecting 2 QBBs and 1 IOB, which
communicate with the rest of the system through the SPS. The MPB also houses the
system clock and connects all other system boards.

Distributed Power Supply (DPS) Unit

Each DPS Unit supplies 48V AC/DC power to the server. Each module is equipped with 4
DPS units for full redundancy.

Platform Administration Processor (PAP) Unit
The PAP Unit hosts all server administration software, in particular Platform Administration
and Maintenance (PAM) software.

KVM Switch
The KVM Switch allows the use of a single keyboard, monitor and mouse for the local
server domains and the local PAM console.
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Slideaway Console / Console Drawer
The Console contains the keyboard, monitor and touch pad / mouse used for local access
to the server domains and to the PAP Unit.

Disk Subsystem
A SCSI RAID or FC disk subsystem is required for OS disk partitions.

Additional Peripherals
Additional peripherals such as disk subsystems, storage area networks, communication
networks, archiving peripherals etc. can be connected to the server via PCI adapters
located in the IOCs. Such peripherals may either be rack–mounted in the server cabinet (if
free space is available) or in external cabinets.

Server Firmware and Software

Operating Systems (OS)

The server is certified for the following Operating Systems:

• Windows Server 2003, Enterprise Edition

• Windows Server 2003, Datacenter Edition

• Linux Red Hat Advanced Server

• Linux SUSE

BIOS

The BIOS controls the server startup process, dynamic resource allocation (Domain
reconfiguration, hot–plugging), and error handling. The BIOS also includes:

• The Extended Firmware Interface (EFI), which provides the OS with system services.

• The EFI Shell, an autonomous environment used to run Off–line Test & Diagnostic
suites.

Platform Administration and Maintenance (PAM) suite

The PAM Web–based software suite is used to operate, monitor, and configure the server.
PAM can be accessed locally or remotely through Microsoft Internet Explorer or Mozilla
browsers, under the protection of appropriate access rights. PAM provides the
administration functions needed to manage and maintain the server:

• Domain configuration and resource allocation

• Alert or maintenance requests to the Customer Service Center

• Error logging …

Test & Diagnostics suites

The server is delivered with the following T & D suites:

• Online Test & Diagnostic suite

• Offline Test & Diagnostic suite

• Power–On Self–Test suite

NovaScale Master (NSM) Management suite

The NSM software suite allows you to monitor and manage NovaScale Windows and Linux
systems.
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Conformance to Standards

Intel

Bull NovaScale Servers conform to all Intel platform standards:

• ACPI (Advanced Configuration and Power Interface)

• IPMI (Intelligent Platform Management Interface)

• EFI (Extended Firmware Interface)

• SMBIOS (System Management BIOS)

• DIG64 (Developer Interface Guide for Intel[  Itanium[  Architecture)

Windows

Bull NovaScale Servers conform to the standards set out in the Windows Hardware Design
Guide.
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General Recommendations
Bull NovaScale Servers are delivered rack–mounted and pre–cabled in one or more high or
low cabinets, according to the version chosen.

Site preparation must be completed by the pre–arranged delivery date. Any delay due to
non–completion of the site by the pre–arranged date will be considered as the Customer’s
responsibility.

The server is delivered 24 hours in advance of the scheduled installation date. On arrival, it
must be placed, in its packing, in the Computer Room so that it reaches room temperature
before powering up (optimum operating temperature = 22° C + 3° C, hygrometry = 50% +
5%).

 CAUTION:
It is mandatory for the server to be transported vertically. Server cabinets are
extremely heavy and require the use of an elevator. The Data Processing Site
manager must allocate enough personnel to ensure safe handling.

See Appendix A. for server specifications.

Use the Packing Slip to check the number and condition of the shipping boxes prior to
unpacking.

The server is delivered with a box labeled Open Me First containing all the data and items
required for installation.

 Warning: 
To avoid condensation and incorrect handling, the server must be removed from its
packing by authorized Service personnel ONLY, on the scheduled installation date.

 Notes:
40U/19U Rack Cabinets
Instructions on how to install and fit out 40U/19U rack cabinets for Bull NovaScale Servers
and peripheral devices are set out in document Bull 40U/19U Server Rack Cabinets, 86 A1
91EM.

36U Rack Cabinets
Instructions on how to install 36U rack cabinets are set out in the present document.
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Unpacking the 36U Cabinet

 Note:
40U/19U Rack Cabinets
Instructions on how to install and fit out 40U/19U rack cabinets for Bull NovaScale Servers
and peripheral devices are set out in document Bull 40U/19U Server Rack Cabinets, 86 A1
91EM.

 Warning: 
The server must not be unpacked before it has reached room temperature (24 hours
in the Computer Room).

Server cabinets are delivered packed on a pallet with rails for easy unloading. The Data
Processing Site manager must set aside the required working area for unpacking as shown
in the following figure.

100 cm

100 cm

(39.4 in)

(39.4 in)

200 cm

(78.7 in)

50 cm

(19.7 in)

130 cm

(51.2 in)

Cabinet

Pallet

Rails
Pallet Width *

Pallet Depth *

Server Pallet Width * Pallet Depth *

NovaScale 6xx0 Servers 80 cm (32 in) 128 cm (51 in)

Figure 2. Required unpacking area – standard rack cabinet

The following packing items are used to protect server cabinets during shipping:

• anti–condensation barrier packing,

• top, front, rear protective covers,

• pallet,

• loading / unloading rails and ramp,

• plastic straps,

• velcro straps,

• shockwatch and tiltwatch labels.

See Appendix A. Specifications for cabinet packing details.
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 DANGER
Server cabinets are extremely heavy. Authorized Service personnel ONLY may
unpack and physically install cabinets. The instructions set out below are to be
strictly complied with to avoid serious personal injury.

Inspecting 36U Cabinet Packing
Before unpacking, check the indicators on the 2 shockwatch and 4 tiltwatch labels,
positioned as follows on the packing:

Shockwatch labels

• 1 on the front cover,

• 1 on the rear cover.

Tiltwatch labels

• 1 on the front cover,

• 1 on the side cover,

• 1 on the outer side of the internal front door cover,

• 1 on the inner side of the internal front door cover.

If one or more of the indicators are RED, the server may be damaged. Note indicator status
on the bill of lading and carefully inspect the server before powering up.

Indicators

NOTE :
Inspecter l’étiquette détectrice

de choc de cet envoi 

d’accepter la marchandise

AVANT

ATTENTION :

Le TILT est rouge, ne pas
refuser le colis, mais notez–
le sur le bordereau et
vérifiez le contenu

Indicateurs

NOTE: ATTENTION:

Check the Shockwatch label BEFORE
accepting the merchandise.

If the Tiltwatch label is red, make a reserve
on the delivery slip and check packing
contents.

Figure 3. Packing shockwatch and tiltwatch labels
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Removing 36U Cabinet Packing

Tools Required:

• Cutter

• 27 mm wrench

• 17 mm hex wrench

Figure 4. Removing the top, front, and rear covers – standard 36U cabinet

1. Cut the plastic straps with the cutter.

2. Remove the top cover.

3. Remove the rear and front covers by opening the plastic fasteners.

4. Remove the stretch film / condensation barrier packing retaining the loading / unloading
rails and ramp.

5. Unfasten and remove the stoppers surrounding the cabinet.
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Inspecting the Server
A preliminary visual inspection must be performed once the server has been unpacked and
before unloading the cabinets from their pallets.

 CAUTION:
If the inspection indicates an unacceptable safety condition, the condition must be
corrected before powering up the server.

1. Check that the server delivered is compliant with the Purchase Order.

2. Check covers and doors for sharp edges, damage or alterations.

3. Check the correct fit of covers and doors.

4. Open the front and rear doors.

 Note:
Unlock the front door with the key, pull the handle forwards and upwards to disengage the
lock.

5. Check for internal damage, alterations and obvious safety hazards such as broken wires,
sharp edges, or broken insulation.

6. Check internal cables for damage.

7. Check for dirt, water, and any other form of contamination inside the cabinet.

8. Check the voltage label on the back of the cabinet to ensure that it matches the voltage
at the power outlet.

9. Check external power cables for damage.

10. Check correct closure of front and rear doors.

 Note:
Server components and configuration may differ according to the version chosen.
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Unloading the 36U Cabinet
To ensure safe handling, doors and side covers must be removed before unloading cabinets
from their pallet.

Removing the Front Door
The front door can be fitted on the right or left side of the cabinet, according to site
requirements. See Turning the Front Door in the Maintenance and Service Guide.

Tools Required:

• Cabinet key

Figure 5. Removing the front door – 36U cabinet

1. Unlock the front door with the key, pull the handle forwards and upwards to disengage
the lock.

2. Open the front door until it is at a right angle with the front of the cabinet.

3. Firmly grip either side of the door and lift to remove from the hinges (1).

4. Pull the door away from the front of the cabinet (2) and store in a safe place.
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Removing the Rear Door

Tools Required:

• None

Figure 6. Removing the rear door – 36U cabinet

1. Open the rear door at an angle of 60° with the rear of the cabinet.

2. Push the tab at the top of the door upwards to release from the top hinge.

3. Gently disengage the top of the door from the top hinge.

4. Grip either side of the door and lift to remove from the hinges (1).

5. Pull the door away from the rear of the cabinet (2) and store in a safe place.
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Removing Side Covers

Tools Required:

• None

Figure 7. Removing side covers – 36U cabinet

1. Open the rear and front doors.

2. Firmly grip both sides of the side cover.

3. Pull slightly forward (1) and lift to release the side cover from the cabinet fittings (2).

4. Store in a safe place.
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Installing the 36U Cabinet Unloading Rail / Ramp Assembly

Tools Required:

• 17 mm hex wrench

1. Remove the rail fixtures from their packing.

A

B

C

Figure 8. Rail / ramp assembly – 36U cabinet

2. Assemble the two rails and tighten the four bolts with the 17 mm hex wrench (A).

3. Insert the pin at the top of each rail into the small holes on both sides of the pallet (B).

4. Insert the pin at the bottom of each rail into the small holes on both sides of the ramp
(C).



1-16 Installation Guide

5. Manually check that the pallet / rail / ramp assembly is secure.

Figure 9. Assembling / installing unloading rails – 36U cabinet

6. Repeat Steps 1 to 5 for each server cabinet.

Removing the 36U Cabinet Shipping Brackets
Yellow shipping brackets are used to secure cabinet flanges to the pallet during transport.
These brackets must be removed before unloading the cabinet.

Tools Required:

• 27 mm hex wrench

• 17 mm hex wrench

1. Lower the four jacking screws with the 27 mm hex wrench.

Figure 10. Lowering cabinet jacking screws – 36U cabinet

2. Use the 17 mm hex wrench to loosen the shipping brackets on either side of the cabinet.

3. Disengage the left shipping bracket from the cabinet by pushing firmly forwards.
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4. Remove the left shipping bracket and store in a safe place.

Figure 11. Removing cabinet shipping brackets – 36U cabinet

5. Repeat steps 3 and 4 for the right shipping bracket.

6. Position the four cabinet wheels so that they are facing the rear of the cabinet.

Figure 12. Positioning cabinet wheels – 36U cabinet
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7. Raise the four jacking screws with the 27 mm hex wrench.

Figure 13. Cabinet jacking screws and retaining brackets – 36U cabinet

8. Carefully unload the cabinet from the pallet by rolling it slowly down the rail / ramp
assembly.

Figure 14. Unloading the 36U cabinet

9. Roll the cabinet to the location indicated on the Customer’s floor plan.

10.Repeat Steps 1 to 9 for each server cabinet.

Storing Packing Items
All packing items are to be stored in an ancillary room for re–use in the event of relocation
or shipping.

Before proceeding to set up the server, clear and clean the installation area.
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Installing and the Securing the 36U Cabinet

  Important: 
The front door opens flush with the front of the cabinet (180� opening angle) and may
be fitted on either side of the cabinet frame, according to site requirements. Full
access to the cabinet is mandatory for maintenance.
Customers are advised to plan ahead and to provide space for extensions.

Tools Required:

• 27 mm hex wrench

• 8 mm hex wrench

1. Check required service clearance at the rear, front and sides of the server.
 For further information, refer to the Site Preparation Guide.

100 cm
(39.4 in)

100 cm
(39.4 in)

Depth *

150 cm
(59 in)

100 cm
(39.4 in)

Width *

180  left/right 
opening front door

�

Server
Cabinet

Rear door

Server Width * Depth *

NovaScale 6xx0 Servers 65 cm (25.6 in) 113 cm (44.5 in)

Figure 15. Single cabinet service clearance – 36U cabinet
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100 cm
(39.4 in)

100 cm
(39.4 in)

Depth *

150 cm
(59 in)

100 cm
(39.4 in)

Width *

Main
CabinetCabinet

Extension

Rear doors

180° left/right

opening front doors

Width *

Server Width * Depth *

NovaScale 6xx0 Servers 65 cm (25.6 in) 113 cm (44.5 in)

Figure 16. Dual cabinet service clearance – 36U cabinet

  Important: 
It is mandatory for the extension cabinet to be placed to the right of the main cabinet.
The extension cabinet is installed and secured in the same way as the main cabinet.
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2. Take care to leave sufficient access to raised floor cable cut–outs.

35 cm
(14 in)

< >

15 cm
(6 in)

<

<

� � � � � �
� � � � � �
� � � � � �
� � � � � �

Cable cut–out

Server Cable cut–out

NovaScale 6xx0 Servers Front (main cabinet) Rear (I/O cabinet)

Figure 17. Cabinet cable cut–outs – 36U cabinet

3. Lower the four jacking screws with the 27 mm hex wrench and lock firmly into place to
secure the cabinet.

Figure 18. Locking jacking screws – 36U cabinet

4. Check cabinet stability and horizontality.

5. Repeat Steps 1 to 4 for each server cabinet.

 DANGER
The cabinet is extremely heavy. It is mandatory for cabinet jacking screws to be
locked safely into place before use or maintenance. Incorrect installation may result
in serious personal injury or damage to components.
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Removing CSS Module Shipping Brackets
Each Bull NovaScale Server CSS module is equipped with five yellow shipping brackets at
the rear of the standard 36U cabinet. Once the server has been installed and correctly
secured, all shipping brackets must be removed.

Yellow
Shipping
Brackets

Figure 19. Removing CSS module shipping brackets – rear – 36U cabinet

1. Loosen and remove the 4 shipping brackets on either side of the CSS module / cabinet
with the 8 mm hex wrench.

2. Loosen and remove the horizontal shipping bracket above the CSS module. The cable
retaining plate is no longer secured to the cabinet.

3. Use the 4 bolts from the horizontal shipping bracket to re–secure the cable retaining
plate to the cabinet.

  Important: 
Take care to store shipping brackets and fittings with other packing items.
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Inspecting Internal Components and Cabling
The server is delivered pre–tested and ready for use.

A general preliminary visual inspection was carried out before unloading the server. Now
that the server has been secured into place in the Computer Room, a thorough visual
inspection of internal components and cabling should be carried out before refitting side
covers and doors.

 CAUTION:
If the inspection indicates an unacceptable safety condition, the condition must be
corrected before powering up the server.

1. Visually check internal cables for damage.

2. Visually check system components for damage.

3. Manually check internal cable connections.

4. Visually check external power cables for damage.

 Note:
If you need to check CSS Module components, refer to the Maintenance and Service Guide.

For guidance with cabling, see Appendix C.Cabling Diagrams, on page C-1.
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Refitting Doors and Side Covers
Once the inspection is complete, doors and side covers must be refitted before powering up
the server. 

Refitting the Front Door

Tools Required:

• Cabinet key

Figure 20. Refitting the front door – 36U cabinet

1. Firmly grip either side of the door and place at a right angle with the front of the cabinet.

2. Carefully lower the door onto the cabinet hinges.

3. Close the door and engage the lock by lowering the handle and pushing it back into the
recess.

4. Lock the front door with the key.
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Refitting the Rear Door

Tools Required:

• None

Figure 21. Refitting the rear door – 36U cabinet

1. Firmly grip either side of the door and hook carefully onto the bottom hinge.

2. Push the tab at the top of the door upwards and pull the door onto the top hinge.

3. Ease the tab at the top of the door back into place and close the door.
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Refitting Side Covers

Tools Required:

• None

Figure 22. Refitting side covers – 36U cabinet

1. Firmly grip both sides of the side cover.

2. Carefully hook the side cover onto the cabinet fittings (1) and lower into place (2).

3. Close the rear and front doors.
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Getting to Know the Server

 Note:
Abbreviations and acronyms are documented in the Glossary.

NovaScale 6080 Server
The server is delivered rack–mounted and pre–cabled in a high cabinet, containing the
following components:

Front  Rear

1 CSS module with midplane, redundant
power supply and AC power cable

11 Console drawer with monitor, keyboard and
mouse

2 DPS units 12 KVM switch

3  2 IOB (s)  with: 13 1 or two SCSI or FC disk rack(s) with RAID
controller(s) and disks

4 IOR 14 PAP unit with CD–ROM drive, FDD and
disk(s)

5 2 USB ports 15 PDU with AC power cable

16 Hub with power bar

6 DVD / CD–ROM drive NovaScale 6080 configuration:
– QBB #0 and QBB #3

7 PCI hot plug board (11 slots)
– QBB #0 and QBB #3

8 PMB

9 2 QBBs with fan boxes See Glossary for abbreviations and acronyms.

10 SPS fan boxes

See Glossary for abbreviations and acronyms.

Figure 23. NovaScale 6080 Server components (example)
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NovaScale 6160 Server
The server is delivered rack–mounted and pre–cabled in a high cabinet, containing the
following components:

Front  Rear

1 CSS module with midplane, redundant
power supply and AC power cable

11 Console drawer with monitor, keyboard and
mouse

2 DPS units 12 KVM switch

3  2 IOB (s)  with: 13 1 or two SCSI or FC disk rack(s) with RAID
controller(s) and disks

4 IOR 14 PAP unit with CD–ROM drive, FDD and
disk(s)

5 2 USB ports 15 PDU with AC power cable

16 Hub with power bar

6 DVD / CD–ROM drive NovaScale 6160 configuration:
– QBB #0, QBB #1, QBB #2, and QBB #3

7 PCI hot plug board (11 slots)
– QBB #0, QBB #1, QBB #2, and QBB #3

8 PMB

9 4 QBBs with fan boxes See Glossary  for abbreviations and acronyms.

10 SPS fan boxes

See Glossary  for abbreviations and acronyms.

Figure 24. NovaScale 6160 Server components (example)
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NovaScale 6320 Server
The server is delivered rack–mounted and pre–cabled in two high cabinets, a Main Cabinet
and an I/O Cabinet.

Main Cabinet
The main cabinet contains the following components:

Front  Rear

1 2 CSS modules, each with midplane, redun-
dant power supply and AC power cable

8 PMB

2 DPS units 9 1 to 4 QBBs with fan boxes

3  1 or 2 IOB (s)  with: 10 SPS fan boxes

4 IOR 15 PDU with AC power cable

5 2 USB ports NovaScale 53206320 configuration:5 2 USB ports NovaScale 53206320 configuration:
– QBB #0, QBB #1, QBB #2, and QBB #3 Module 0

6 DVD / CD–ROM drive
– QBB #0, QBB #1, QBB #2, and QBB #3 Module 0
– QBB #0, QBB #1, QBB #2, and QBB #3 Module 1

7 PCI hot plug board (11 slots)

– QBB #0, QBB #1, QBB #2, and QBB #3 Module 1

See Glossary for abbreviations and acronyms.

Figure 25. NovaScale 6320 Server main cabinet components (example)
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I/O Cabinet
The I/O cabinet contains the following components:

I/O cabinet with SCSI disks  I/O cabinet with FC disks

                      

Front

11 Console drawer with monitor, keyboard and mouse

12 KVM switch

13 1 up to 4 SCSI disk rack(s)  with RAID controller(s) and disks, or
1 or two FC disk rack(s) with RAID controller(s) and disks

14 PAP unit with CD–ROM drive, FDD and disk(s)

15 PDU with AC power cable

16 Hub with power bar

Figure 26. NovaScale 6320 Server I/O cabinet components (examples)
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Server Components

Central Subsystem (CSS) Module
The CSS Module houses core hardware components.

NovaScale 6080/6160 Server
The server is equipped with one CSS module, located at the bottom of the cabinet.

1 MidPlane (MP)
This active board is used to interconnect the QBBs, IOBs and the PMB.
2 SPS fan boxes
This active board is used to interconnect the QBBs, IOBs and the PMB.
2 SPS fan boxes
Each Midplane is equipped with two redundant fan boxes for cooling.

1, 2, 3 or 4 QBB (Quad Brick Board) subsets:
Each QBB subset houses:

• 1 mother board
• 2 memory boards
• 4 processors
• 16 DIMMs

1, 2, 3 or 4 QBB fan boxes:
Each QBB subset is equipped with a fan box for cooling.

2 IOBs (Input / Output Box):

Each IOB box houses:

• 1 IOB (Input / Output Board)

• 1 PHPB (PCI Hot Plug Board)

• 11 hot–plug PCI–X (100–133 MHz) slots with optional:

– 1 SCSI HBA
– 1 PCI SCSI card
– 1 PCI FC card
– 1 PCI Giga Ethernet card
– 8 free slots

• 1 IOR (Input / Output Riser):

– 2 A–type USB ports

• 1 RJ45 10/100 Mbps Ethernet port

– 2 DB9–M RS232 serial ports
– 1 HD15–F VGA port

• 1 DVD/CD–ROM drive
• 1 LS240 drive (optional)

Each IOB is cooled by the corresponding QBB fan box.

1 PMB (Platform Management Board):
This active board links the server to the Platform Administration Processor (PAP) Unit
(via an Ethernet link).

Figure 27. NovaScale 5080/5160 ServerNovaScale 6080/6160 Server CSS module features
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NovaScale 6320 Server
The server is equipped with two CSS modules, located at the top and bottom of the main
cabinet.

1MidPlane (MP)
2 SPS fan boxes
1MidPlane (MP)
2 SPS fan boxes

1, 2, 3 or 4 QBB (Quad Brick Board) subsets

1, 2, 3 or 4 QBB fan boxes

1 or 2 IOBs (Input / Output Box)

1 PMB (Platform Management Board)

Figure 28. NovaScale 6320 Server CSS module features

 Note:
See Figure 27 for details.
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Integrated Platform Administration Processor (PAP) Unit
The PAP unit is linked to the server via the Platform Management Board (PMB). It hosts
Platform Administration Software (PAM). According to version, the PAP unit is located in the
center of a high cabinet or at the top of a low cabinet.

Or

PAP Unit 1U PAP Unit 2U

• 1 PIII / 1 GHz PC

– 512 Mb RAM

– 2 x 36 Gb disks (soft mirrored) (3)

– 1 free disk slot (4)

– 1 CD/DVD–ROM drive (1)

– 1 FDD(2)

– 2 serial ports

– 2 PCI slots

– 2 Ethernet ports (1 free)

• 1 P4SCi / 2.6 GHz PC

– 2 x 512 Mb RAM

– 2 x 80 Gb disks (RAID) (3)

– 4 free disk slots

– 1 CD/DVD–ROM drive (1)

– 1 FDD (2)

– 2 serial ports

– 3 PCI slots

– 2 x 1 Gb Ethernet ports (1 free)

– 4 USB ports (2 front  (4)+ 2 rear ))

• Microsoft Windows operating system

• Internet Explorer software

• PAM software

• 1 power cable

Figure 29. PAP unit
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Integrated Console
According to version, the integrated console is located in the center of a high cabinet or at
the top of a low cabinet.

Slideaway Console
The Slideaway Console contains the keyboard, monitor and touch pad used for local access
to the server and to the Platform Administration Processor (PAP) Unit.

• 1 monitor

• 1  QWERTY keyboard and touch pad

• 1 power cable

Figure 30. Slideaway Console features

Console Drawer
The Console Drawer contains the keyboard, monitor and mouse used for local access to the
server and to the Platform Administration Processor (PAP) Unit.

• 1 pull–out table top

• 1 monitor

• 1  QWERTY keyboard and mouse kit

• 1 power cable

Figure 31. Console drawer features
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Keyboard / Video / Mouse (KVM) Switch
The KVM Switch allows the use of the integrated console for the local server and the local
Platform Administration and Maintenance console.

8–Port KVM Switch

Or

• 8 ports

• 1 power cable

Figure 32. KVM switch features

16–Port KVM Switch

• 16 ports

• 1 power cable

Figure 33. KVM switch features
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SR–0812 SCSI RAID Disk Rack
The SR–0812 SCSI RAID Disk Rack is delivered with three system disks (two RAID#1 and
one spare disk per domain) and offers five empty slots for Customer data disks. One
SR–0812 SCSI RAID Disk Rack is delivered per domain. According to version, the Disk
Rack is located in the main or I/O cabinet.

1 OS disks

2 Spare disks

3 Optional data disks

• 8 slots

• 1 RAID controller card

• 6 disks (3 per domain: 2 RAID#1 + 1 spare)

• 2 power cables (redundant power supply)

Figure 34. SR–0812 SCSI RAID disk rack features

SJ–0812 SCSI JBOD Disk Rack
The SJ–0812 SCSI JBOD Disk Rack is delivered with six system disks (two RAID#1 and
one spare disk per domain) and offers two empty slots for Customer data disks. According
to version, the Disk Rack is located in the main or I/O cabinet.

1 OS disks

2 Spare disks

3 Optional data disks

• 8 slots

• 6 disks (3 per domain: 2 RAID#1 + 1 spare)

• 2 power cables (redundant power supply)

Figure 35. SJ–0812 SCSI JBOD disk rack features
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SJ–0812 SCSI JBOD Extension Disk Rack
The SJ–0812 SCSI JBOD Extension Disk Rack offers eight empty slots for Customer data
disks. The Extension Disk Rack is located in the center of the cabinet, above the Main Disk
Rack.According to version, the Extension Disk Rack is located in the main or I/O cabinet.

• 8 slots

• 2 power cables (redundant power supply)

Figure 36. SJ–0812 SCSI JBOD extension disk rack features
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FDA 1300 FC Disk Rack
The FDA 1300 FC Disk Rack is delivered with six system disks (two RAID#1 and one spare
disk per domain) and offers nine empty slots for Customer data disks. According to version,
the Disk Rack is located in the main or I/O cabinet.

1 OS disks

2 Optional data disks

3 Spare disk

• 15 slots

• 2 FC RAID controller cards, 1 FC port per controller

• 3 disks (2 RAID#1 + 1 spare)

• 6 disks (3 per domain: 2 RAID#1 + 1 spare)

• 2 power cables (redundant power supply)

Figure 37. FDA 1300 FC disk rack features
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FDA 2300 FC Disk Rack
The FDA 2300 FC Disk Rack is delivered with three system disks (two RAID#1 and one
spare disks) and offers 12 empty slots for Customer data disks.According to version, the
Controller Unit and Disk Unit are located in the main or I/O cabinet.

1 OS disks

2 Optional data disks

3 Spare disk

• 1 controller unit & 1 disk unit

• 15 slots

• 2 FC RAID controller cards, 2 FC ports per controller

• 3 disks (configuration: 2 in RAID#1 + 1 spare)

• 2 power cables (redundant power supply)

Figure 38. FDA 2300 FC disk rack features
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FDA 1300 FC Extension Disk Rack
The FDA 1300 FC Extension Disk Rack offers15 empty slots for Customer data disks. The
Extension Disk Rack is located in the center of the cabinet, above the Main Disk Rack. The
Disk Rack is located in the center of the cabinet, above the PAP Unit.According to version,
the Disk Rack is located in the main or I/O cabinet.

• 15 slots

• 2 power cables (redundant power supply)

Figure 39. FDA 1300 FC extension disk rack features
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Ethernet Hub
The optional Maintenance LAN Ethernet Hub is used to connect PMB, PAP Unit and
external FDA FC Disk Rack Ethernet ports.

Ethernet Hub – 8 ports

– 1 power cable

– 1 power bar

Figure 40. Ethernet hub features

USB Modem
The optional USB modem is used to transmit Autocalls to the Remote Maintenance Center,
if the Customer’s maintenance contract includes the Autocall feature.

USB Modem – 1 USB cable

– 1 RJ11 cable

Figure 41. USB modem features
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Power Distribution Unit (PDU)
The PDU supplies mains power to the PAP unit, the external Disk Rack, the KVM Switch,
the Integrated Console, and the Ethernet Hub. When the server is equipped with an FDA
1300 FC or an FDA 2300 FC, the PDU also supplies mains power to the Power Bar. The
PDU is located in the top left part of the cabinet.According to version, the PDU is located in
the top left part of the main or I/O cabinet.

                  Front       Rear

• 6 (8A) sockets (front):

• 2 (1A) sockets (rear):

• 1  (20A) power cable

Figure 42. PDU features
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Chapter 2. Setup Procedure

This chapter  explains the procedures required to set up and start the server for the first
time. It includes the following topics:

• Accessing Server Components, on page 2-2

• Checking PMB Code Wheels, on page 2-7

• Checking Server Cabling and Connecting Inter–Cabinet Cables, on page 2-7

• Mounting Power Supply Cable Sockets, on page 2-11

• Connecting the Server to the Site Power Supply, on page 2-14

• Launching PAM Software, on page 2-15

• Checking Server Status via PAM, on page 2-18

• Toggling the Local / Integrated Console Display, on page 2-20

• Powering Up / Down Server Domains, on page 2-20

• Completing PAP Unit Configuration, on page 2-29

• Configuring Customer Information, on page 2-31

• Configuring Autocalls, on page 2-32

• Changing the iStorage Manager User Name and Password, on page 2-34

• Connecting the PAP Unit to the Customer’s Enterprise LAN, on page 2-35

• Connecting to the PAM Web Site from a Remote Computer/Workstation, on page 2-36

• Enabling Remote Access to iSM on the Client Computer, on page 2-36

• Completing Operating System Setup, on page 2-38

• Connecting the Server to the Enterprise LAN, on page 2-50

• Connecting External Devices, on page 2-51

• Testing Network Connections, on page 2-52

• Testing Autocalls, on page 2-52

• Completing the PAM Installation Intervention Report, on page 2-52

• Renaming the Central Subsystem, on page 2-53

• Setting up PAP Unit Users, on page 2-61

• Backing Up / Restoring PAM Configuration Data, on page 2-63
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Accessing Server Components

Opening the Front Door

Tools Required:

• Cabinet key

Figure 43. Opening the front door

1. Unlock the front door with the key.

2. Pull out the locking mechanism and turn to open.

3. Open the door as required (90° / 180°).

Closing the Front Door
1. Close the door.

2. Turn the locking mechanism to close and push back into place.

3. Lock the front door with the key.
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Opening / Closing the Slideaway Console
The server is equipped with an integrated console for local administration and maintenance
operations.

Figure 44. Slideaway console

To open the slideaway console:

1. Slide the console forward until it clicks into place.

2. Use the front bar to lift the screen panel into position.

To close the slideaway console:

1. Press the 2 buttons marked PUSH on either side of the keyboard panel to release the
console.

2. Lower the front bar to close the screen panel.

3. Slide the console back into the cabinet.
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Setting up the Console Drawer
The server is equipped with an integrated console for local administration and maintenance
operations. This console will be required during the installation procedure to configure the
server and to check operational status. To set up the system console, proceed as follows:

1. Pull out the console drawer and lower the magnetic front flap.

Figure 45. Lowering the console drawer flap

2. Pull on the tab to extend the mouse tray.

Figure 46. Extending the mouse tray

3. Manually position the monitor and check that the vacation switch on the right–hand side
of the monitor is ON.

Figure 47. Positioning the monitor
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4. Install the mouse on the extendable tray, ready for use.

Figure 48. Console ready for use

  Important: 
The keyboard and mouse connectors, fitted to the rear of the console drawer with
velcro retainers, may become loose during shipping. Once the monitor is positioned,
manually check keyboard and mouse cable connections.

Closing the Console Drawer
1. Replace the mouse on the pad inside the drawer and push on the tab to replace the

mouse tray in its housing.

2. Raise the magnetic front flap.

3. Manually lower the monitor.

4. Press firmly on the tabs on each side of the drawer and push the drawer back into the
cabinet.

(1) Tab (1 on each side of the drawer)

Figure 49. Closing the console drawer
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Accessing the PAP Unit CD–Rom and Diskette Drives

Tools Required:

• PAP unit key

The PAP unit CD–Rom and diskette drives are located behind the front bezel. To access the
CD–Rom and/or diskette drives, unlock the front bezel with the PAP unit key and remove.

Figure 50. PAP Unit CD–Rom and Diskette Drives
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Checking PMB Code Wheels
The Platform Management Board (PMB) links the server to the PAP unit, which displays
server status data on the console monitor. The PMB is equipped with two code wheels used
to indicate the server cabinet number and the CSS module number. These code wheels are
set prior to shipping (factory default setting), according to the configuration ordered.

Configuration
Cabinet Hexadecimal

Code (0 to F)
CSS Module Hexadecimal

Code (0 to F)

NovaScale 6080/6160 Server 0 0

NovaScale 6320 Server 0
0

0 (module 0)
1 (module 1)

Table 1. PMB code wheel settings – default single server configuration

  Important: 
Code wheels may change position during shipping. Check code wheel position
before powering up the system.

Figure 51. PMB code wheels
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Extended and Cluster Systems
Up to 16 CSS modules can be linked, via a PMB to the PAP unit. PMB code wheels allow
the identification of each cabinet and each CSS module in the Customer’s configuration.

Example of PMB code wheel settings for a system with 3 cabinets, each containing 2
modules:

Cabinet 1 Cabinet 2 Cabinet 3

Cabinet Hexadecimal Code (0 to F) 0 1 2

CSS Module_0 Hexadecimal Code (0 to F) 0 0 0

CSS Module_1 Hexadecimal Code (0 to F) 1 1 1

CSS Module_2 Hexadecimal Code (0 to F) 2 2 2

Table 2. PMB code wheel settings – multiple server configuration example
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Checking Server Cabling and Connecting Inter–Cabinet Cables

  Important: 
Cables to external peripherals must NOT be connected before powering up the server
for the first time.
These cables must only be connected once server operation has been checked.

All internal cabinet cables are pre–connected before shipping. However, cables may
become loose during shipping and you are advised to check for loose cables before
powering up the server. See Cabling Diagrams, on page C-1 for details.See Cabling
Diagrams, on page 0 for details.

Connecting NovaScale 6320 Server Inter–Cabinet Data Cables
Once you have checked for loose cables, you can proceed to connect the following
inter–cabinet data cables:

• PMB – Ethernet hub data cables, see details on page C-40

• IOR – 16–port KVM switch data cables, see details on page C-41

• IOB HBA – SR–0812 SCSI RAID disk rack data cables, see details on page C-43

• IOB HBA RAID – SJ–0812 SCSI JBOD disk rack data cables, see details on page C-42

• IOB HBA – FDA 1300 FC disk rack data cables, see details on page C-43

• IOB HBA – FDA 2300 FC disk rack data cables, see details on page C-44

These cables are already connected to the PMB, IOR, and IOB HBAs located in the main
cabinet and must now be connected to the Ethernet hub, KVM switch, and disk racks in the
I/O cabinet.

To connect inter–cabinet data cables:

1. Uncoil the required cable and check the “From” and “To” labels.

2. Use the corresponding cabling diagram to locate the required device port in the I/O
cabinet. See Inter–Cabinet Cabling Diagrams, on page 0 for details.

3. Carefully guide the cable down through the right–hand cable inlet and into the cable
cut–out at the base of the main cabinet.

><

<

<

113 cm
(44.5 in)

65 cm
(25.6 in)

FRONT

35 cm
(14 in)

< >

15 cm
(6 in)

<

<

CABINET

REAR

� � � � �
� � � � �
� � � � �
� � � � �

Cable cut–out

Figure 52. Cabinet cable cut–outs
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4. From the plenum space, carefully guide the cable up through the cable cut–out at the
base of the I/O cabinet.

5. Connect the cable to the device port.

6. Repeat Steps 1 to 5 for each inter–cabinet data cable.

For further details, see Cabling requirements on page 0.
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Mounting Power Supply Cable Sockets

 CAUTION:
To be performed by a certified electrician only.

Tools Required

• Multimeter

• Phillips screwdriver

• Velcro fasteners

Europe, Japan, Brazil

Server power cables are equipped with ready–mounted IEC309 plugs and dedicated
sockets for connection to the site power supply.

As required in the Site Preparation Guide, the Customer has provided the following power
supply cables to the cable cut–outs at the base of the cabinet:

Server Power Suppy Cable

NovaScale 6xx0 Servers 1 x 20A power supply cable per PDU1

1 x 20A power supply cable per CSS Module2

 Note:
1 The Power Distribution Unit (PDU) cable has an extra cable length of 1.5 meters.
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United States of America

Server power cables are equipped with ready–mounted NEMA L6–30P plugs. The
Customer is responsible for supplying appropriate NEMA L6–30R sockets for connection to
the site power supply.

Figure 53. US plug characteristics

As required in the Site Preparation Guide, the Customer has provided the following power
supply cables (and appropriate NEMA L6–30R sockets) to the cable cut–outs at the base of
the cabinet:

Server Power Suppy Cable

NovaScale 6xx0 Servers 1 x 20A power supply cable per PDU1

1 x 20A power supply cable per CSS Module2

 Note:
1  The Power Distribution Unit (PDU) cable has an extra cable length of 1.5 meters.
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PDU Power Cable Socket
1. Check that the power supply cable is not live with the multimeter.

2. Carefully guide the PDU power supply cable (cable with extra 1.5 meter length) through
the left–hand cable inlet at the base of the cabinet.

3. Check that the power supply cable is long enough for connection to the PDU.

4. Remove the power socket from the PDU plug.

5. Unscrew the base of the socket (A), insert the cable through the socket base (B), and
wire to the socket head, as shown in Figure 54.

Figure 54. PDU power cable socket

6. Screw the socket base back to the socket head (C).

7. Check for < 0.1 ohm resistance between the grounding pin on the power cable plug and
the metal frame with the multimeter.

8. Connect the power supply cable socket to the PDU power cable plug.

9. Use velcro fasteners to secure the cable into place along the cabinet frame.

10.Check that the power switches on the peripheral devices are set to ON:

Peripheral Device Power Switch Location

KVM Switch 1 switch – rear left

PAP Unit 1 switch – front right



2-14 Installation Guide

Connecting the Server to the Site Power Supply

  Important: 
Do NOT connect external data cables before powering up the server for the first time
on the Customer’s premises.

The Customer is responsible for ensuring that the electrical network is compliant with the
standards set out in the Site Preparation Guide, 86 A1 87EF.

 CAUTION:
Only duly certified electricians may connect the server to the power supply, under the
Customer’s responsibility. The server is NOT equipped with a circuit breaker. The
circuit breakers referred to in this section are the SITE circuit breakers supplied by
the Customer.

Safety Recommendations

 DANGER
An electrical outlet that is not correctly wired could place hazardous voltage on metal
parts of the server or the devices that attach to the server. It is the Customer’s
responsibility to ensure that the outlet is correctly wired and grounded to prevent an
electrical shock. 
Use one hand, when possible, to connect or disconnect signal cables to prevent a
possible shock from touching two surfaces with different electrical potentials.

 CAUTION:
The server is equipped with three–wire (phase/phase/ground) power cables for user
safety. Use these power cables with properly grounded electrical outlets to avoid
electrical shock.

1. The server has more than one power supply cable. Follow procedures for removal
of power from the server when directed.

2. Energy hazard, remove all jewelry before servicing.
3. Check that the dedicated power supply circuit breakers are OFF.

Powering Up the Server to the Standby Mode
Once the PDU cables have been connected to the power outlets at the base of the cabinet,
request the Customer to turn the site power supply circuit breakers ON.

The Platform Management Board (PMB) in each CSS module automatically powers up to
the standby mode (48V) and the Platform Administration Processor (PAP) unit automatically
boots Microsoft Windows software. Server operation can now be checked.

 Note:
It may take several seconds for something to be displayed on the monitor. If the server does
not initialize to standby (48V), or if an incident occurs, see Chapter 3. Troubleshooting.
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Checking Server Operation
Once the server has been installed and powered up, correct operation must be checked.

  Important: 
The server must be fully checked with factory default data.
See the Read Me First booklet delivered with the system 24 hours before the scheduled
installation date for factory default data.

When the server check has been successfully completed, the authorized Customer Service
Engineer in charge of installing the system will re–configure the system with Customer data.
See Customizing the Server on page 0.

Launching PAM Software
The server is equipped with an integrated Platform Administration and Maintenance
software package, otherwise known as PAM software.

One part of PAM software is an embedded application (MAESTRO) running on the Platform
Management Boards (PMB) and the other is an external application running on the Platform
Administration Processor (PAP) unit under Microsoft Windows.

You will use the secured PAM Web–based interface to operate, monitor, and configure the
server.

Once the Microsoft Windows software on the PAP unit has been booted, you will be
requested to supply a User Name and Password to open a Windows)  session. The session
MUST be started for the first time with the following factory default User Name and
Password:

User Name Administrator

Password administrator

  Important: 
The factory default User Name and Password are used by the authorized Customer
Service Engineer during the setup procedure ONLY.
Factory default data must be replaced by Customer data once the system check has
been successfully completed. See Completing PAP Unit Configuration on page 0.
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To complete installation, you need to open a Customer Administrator and a Support
Administrator PAM session.

To open a Customer Administrator PAM session:

1. From the Microsoft Windows desktop, double–click the Internet Explorer icon
(http://localhost/PAM).

2. When prompted, request the Customer Administrator to enter the default User Name
and Password:

Customer Administrator

User Name Administrator

Password administrator

The PAM home page appears.

 Note:
The PAM tree building process may take one to two minutes.

To open a Support Administrator PAM session:

1. From the Microsoft Windows desktop, double–click the Internet Explorer icon
(http://localhost//PAM).

2. When prompted, enter the predefined User Name and Password.

The PAM Home Page appears.

 Note:
If an error dialog box appears, see Chapter 3. Troubleshooting. 
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PAM User Interface
The PAM user interface is divided into three areas in the browser window: a Status pane, a
PAM Tree pane, and a Control pane.

Status Pane Control Pane

PAM Tree Pane

Figure 55. PAM user interface

 Note:
For further details about the PAM user interface, please consult the User’s Guide.
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Checking Server Status via PAM
The PAM user interface allows you to check system status at a glance. If the Functional
Status icon in the Status pane and the CSS Availability Status bar are green, the server
is ready to be powered up.

PAM Status Pane
The Status pane, which is automatically refreshed every few seconds, provides quick
access to the following synthetic information:

• Functional Status: if the system is operating correctly, the status icon is green,

• Event Messages: shows the number and maximum severity of pending event messages,

• CSS Availability Status: if the CSS Module is present, configured correctly, and is ready
to operate, the status bar is green.

Figure 56. Status pane

CSS Availability Status

NovaScale 6080/6160 Servers

When the CSS Module is operating correctly, the CSS Availabilty Status bar is green. If the
CSS Module is not operating correctly, the bar is red.

NovaScale 6320 Servers

The CSS Availabilty Status bar is divided into two zones.

If the CSS Modules are operating correctly, the CSS Availabilty Status bar is green.

If the CSS Modules are not operating correctly, the bar is red.

If one of the CSS Modules is not operating correctly, half the bar is red.

CSS Module_0  not available
Bar red

Figure 57. CSS Module availability status bar
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PAM Tree Pane

 Note:
The PAM tree builiding process may take one to two minutes. The PAM tree pane is
refreshed on request.

The PAM Tree pane provides access to server administration and maintenance features:

Tree Nodes Function

Domain Manager to power on / off and manage domains. 

Hardware Monitor to display the status of hardware components and assemblies. 

History Manager to view logs and manage archives.

Servicing Tools to install, maintain, and update the server.

Configuration Tasks to customize server features.

Table 3. PAM Tree nodes

PAM Tree Toolbar

The PAM Tree toolbar, located at the top of the PAM Tree, is used to refresh, expand, or
collapse the tree display.

Toolbar Buttons Explanation

Refresh /rebuild the PAM Tree to view changes.

Expand the complete tree.

Collapse the complete tree.

Expand selected node.

Collapse selected node.

View the related Help topic.

Figure 58. PAM Tree toolbar

PAM Control Pane
When an item is selected in the PAM Tree pane, details and related commands are
displayed in the Control pane, which is automatically refreshed at one minute intervals.
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Toggling the Local / Integrated Console Display
During the powering up / down sequences, you will be requested to toggle the local /
integrated console from the PAP unit display to the server domain display, or vice versa, as
explained below.

 CAUTION:
Access to the local / integrated console should be restricted to Customer / Support
Administrators and Operators ONLY to avoid inadvertent damage to software and/or
hardware components.

The KVM Switch allows the integrated console to be used as the local server domain and
local PAP unit console. KVM ports are configured as shown in Table 4.

8–Port KVM Switch Console Display Domain

Port A PAP Unit N/A

Port B CSS0–Mod0–IO0 MyOperations_1

Port C CSS0–Mod0–IO1 MyOperations_2

16–Port KVM Switch Console Display Domain

Port 1 PAP Unit N/A

Port 3 CSS0–Mod0–IO0 MyOperations_1

Port 4 CSS0–Mod0–IO1 MyOperations_2

Port 5 CSS0–Mod1–IO0 MyOperations_3

Port 6 CSS0–Mod1–IO1 MyOperations_4

Table 4. KVM port configuration

You can easily toggle from the server domain display to the PAP unit display, or vice versa:

1. From the keyboard, press the Control key twice to display the KVM Switch Command
Menu.

2. Select the required port with the ↑↓ keys and press Enter.

3. The selected display appears on the Console monitor.

Powering Up / Down Server Domains
When server status has been checked – system functional status icon and CSS availability
status bar green in the Status pane – the server can be powered up.

To power up / down the server, see:

• Powering Up / Down the NovaScale 6080/6160 Server Domains, on page 2-21.

• Powering Up / Down NovaScale 6320 Server Domains, on page 2-25.
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Powering Up / Down NovaScale 6080/6160 Server Domains
The NovaScale 6080/6160 Server is designed to operate as two hardware–independent
SMP systems, or domains.

For easy configuration and optimum use of the physical and logical resources required for
simultaneous operation, domains are defined via the PAM Domain Scheme wizard. For
further details about domain configuration, see Configuring Domains, in the User’s Guide.

The server is delivered with a default scheme, or configuration file, called
MyOperationsScheme, containing two domains. An Operating System instance is
pre–installed on each domain boot disk (EFI LUN).  According to Customer requirements,
identical or different Operating System instances may be pre–installed on each EFI LUN.
The default scheme allows domains to be booted simultaneously or independently. A brief
summary of the organization of physical and logical resources in MyOperationsScheme is
given in the following table.

 Note:
In the screen shots used in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–1 and an instance of Linux is pre–installed on MyOperations–2.

MyOperationsScheme Organization

Domain Identity: MyOperations–1

Hardware Cell Cell_0

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0

IOB Module0_IOB0

QBBs Module0_QBB0, Module0_QBB1

Domain KVM Ports ***CSS0_Mod0_IO0

Domain Identity: MyOperations–2

Hardware Cell Cell_1

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU1

IOB Module0_IOB1

QBBs Module0_QBB2, Module0_QBB3

Domain KVM Ports ***CSS0_Mod0_IO1

* <MyServer> = default server name, e.g.: NS6080–0, NS6160–0

** EFI LUN: xLUx = boot LUN device location (ModxLUIOx):
      0LU0 = LUN device connected to Module0, IOB0
      0LU1 = LUN device connected to Module0, IOB1
      0LU2 = LUN device connected to Module1, IOB0
      0LU3 = LUN device connected to Module1, IOB1

***CSSx = CSS number, Modx = Module number, IOx = IO box number

Operating System type is indicated by the Microsoft Windows or Linux  logo in the
Domain Identities box.

 Note:
The NovaScale 6080 Server is equipped with QBB_0 and QBB_3, only.

Table 5. MyOperationsScheme organization – mono–module server

To power up / down server domains:
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 Note:
If an error dialog box appears during this sequence, see Chapter 3. Troubleshooting. 

1. From the Customer Administrator PAM Tree, click Domain Manager to open the
Control pane. You are invited to load a Domain Scheme.

2. Click Schemes. The Schemes List dialog opens displaying the pre–configured scheme.

3. Select MyOperationsScheme and click Apply.

Figure 59. Domain schemes list dialog

4. When requested, click Yes to confirm. MyOperations–1, MyOperations–2, domains are
loaded in the Control pane.



2-23Setup Procedure

If the domains are ready to be powered up, INACTIVE is displayed in the Domain State
boxes and the Power On button is accessible for each domain.

CSS availability status indicator 
GREEN

Functional status icon &

Operating System type

Figure 60. Domain Manager Control pane

5. Select MyOperations–1 in the Control pane and click Power On to power up the
domain and associated hardware components.

6. Select MyOperations–2 in the Control pane and click Power On to power up the
domain and associated hardware components.

7. Follow the power–on steps displayed in the Domain State boxes, until RUNNING is
displayed in both Domain State boxes.

Figure 61. Domain state

8. Toggle the local / integrated console from the PAP unit display to MyOperations–1
display. See Toggling the Local / Integrated Console Display, on page 2-20.

9. Wait for the Operating System to load completely. MyOperations–1 domain is now fully
functional.

10.Toggle the local / integrated console from MyOperations–1 display to MyOperations–2
display.

11.Wait for the Operating System to load completely. MyOperations–2 domain is now fully
functional.

12.Check the Operating System environment pre–installed on each domain.
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13.Shut down each Operating System to power down the corresponding domain to the
stand–by mode.

14.Toggle the local / integrated console to the PAP unit display. INACTIVE is displayed in
the Domain State boxes and the Power ON button is accessible for each domain.

 Notes:
For further details about the Power ON / OFF sequences, see Powering ON a Domain and
Powering OFF a Domain in the User’s Guide.
If the functional status icon and/or presence status bar is/are not green or if domains cannot
be powered up / powered down, see Chapter 3. Troubleshooting.

Shutting Down / Restarting the Server
1. From the PAM home page, click File → Close to return to the Microsoft Windows

desktop.

2. Shut down the PAP unit by selecting the Shut Down command in the Start Menu.

3. Request the Customer to turn the two site power supply circuit breakers OFF.

4. Request the Customer to turn the two site power supply circuit breakers ON.

The Platform Management Board (PMB) in the CSS module automatically powers up to
the standby mode (48V) and the Platform Administration Processor (PAP) unit
automatically boots Microsoft Windows software.
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Powering Up / Down NovaScale 6320 Server Domains
The NovaScale 6320 Server is designed to operate as four hardware–independent SMP
systems, or domains.

For easy configuration and optimum use of the physical and logical resources required for
simultaneous operation, domains are defined via the PAM Domain Scheme wizard. For
further details about domain configuration, see Configuring Domains, in the User’s
Guide, 86 A1 21EM.

The server is delivered with a default scheme, or configuration file, called
MyOperationsScheme, containing two or four domains. An Operating System instance is
pre–installed on each domain boot disk (EFI LUN).  According to Customer requirements,
identical or different Operating System instances may be pre–installed on each EFI LUN.
The default scheme allows you to simultaneously boot all domains. A brief summary of the
organization of physical and logical resources in MyOperationsScheme is given in the
following table.

 Note:
In the screen shots used in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–1 and MyOperations–3 and an instance of Linux is pre–installed on
MyOperations–2 and MyOperations–4.
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MyOperationsScheme Organization

Domain Identity: MyOperations–1

Hardware Cell Cell_0

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0

IOB Module0_IOB0

QBBs Module0_QBB0, Module0_QBB1

Domain KVM Ports ***CSS0_Mod0_IO0

Domain Identity: MyOperations–2

Hardware Cell Cell_1

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU1

IOB Module0_IOB1

QBBs Module0_QBB2, Module0_QBB3

Domain KVM Ports ***CSS0_Mod0_IO1

Domain Identity: MyOperations–3
(NovaScale 6320 Server)

Hardware Cell Cell_2

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU2

IOB Module1_IOB0

QBBs Module1_QBB0, Module1_QBB1

Domain KVM Ports ***CSS0_Mod1_IO0

Domain Identity: MyOperations–4
(NovaScale 6320 Server)

Hardware Cell Cell_3

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU3

IOB Module1_IOB1

QBBs Module1_QBB2, Module1_QBB3

Domain KVM Ports ***CSS0_Mod1_IO1

* <MyServer> = default server name, e.g.: NS6080–0, NS6160–0, NS6320–0

** EFI LUN: xLUx = boot LUN device location (ModxLUIOx):
      0LU0 = LUN device connected to Module0, IOB0
      0LU1 = LUN device connected to Module0, IOB1
      0LU2 = LUN device connected to Module1, IOB0
      0LU3 = LUN device connected to Module1, IOB1

***CSSx = CSS number, Modx = Module number, IOx = IO box number

Operating System type is indicated by the Microsoft Windows or Linux  logo in the
Domain Identities box.

Table 6. MyOperations Scheme organization – bi–module server
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To power up / down server domains:

1. From the Customer Administrator PAM Tree, click Domain Manager to open the
Control pane. You are invited to load a Domain Scheme.

2. Click Schemes. The Schemes List dialog opens displaying the pre–configured scheme.

3. Select MyOperationsScheme and click Apply.

Figure 62. Domain schemes list dialog

4. When requested, click Yes to confirm. MyOperations–1, MyOperations–2,
MyOperations–3, and MyOperations–4 domains are loaded in the Control pane.
If the domains are ready to be powered up, INACTIVE is displayed in the Domain State
boxes and the Power On button is accessible for each domain.

Figure 63. Domain Manager Control pane
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5. Select MyOperations–1 in the Control pane and click Power On to power up the
domain and associated hardware components.

6. Repeat Step 5 for each domain in the Control pane.

7. Follow the power–on steps displayed in the Domain State boxes, until RUNNING is
displayed in all Domain State boxes.

Figure 64. Domain state

8. Toggle the local / integrated console from the PAP unit display to the first domain display.
See Toggling the Local / Integrated Console Display, on page 2-20.

9. Wait for the Operating System to load completely. The domain is now fully functional.

10.Toggle the local / integrated console from this domain display to the next domain
display.

11.Wait for the Operating System to load completely. The domain is now fully functional.

12.Repeat Steps 10 and 11 for each domain.

13.Check the Operating System environment pre–installed on each domain.

14.Shut down each Operating System to power down the corresponding domain to the
stand–by mode.

15.Toggle the local / integrated console to the PAP unit display. INACTIVE is displayed in
the Domain State boxes and the Power ON button is accessible for each domain.

 Notes:
For further details about the Power ON / OFF sequences, see Powering ON a Domain and
Powering OFF a Domain in the User’s Guide, 86 A1 21EM.
If the functional status icon and/or presence status bar is/are not green or if domains cannot
be powered up / powered down, see Chapter 3. Troubleshooting.

Shutting Down / Restarting the Server
1. From the PAM home page, click File → Close to return to the Microsoft Windows

desktop.

2. Shut down the PAP unit by selecting the Shut Down command in the Start Menu.

3. Request the Customer to turn the two site power supply circuit breakers OFF.

4. Request the Customer to turn the two site power supply circuit breakers ON in the
following order:

a. PDU breaker.

b. CSS module breaker.

The Platform Management Board (PMB) in each CSS module automatically powers up
to the standby mode (48V) and the Platform Administration Processor (PAP) unit
automatically boots Microsoft Windows software.
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Completing PAP Unit Configuration
• Refer to the PAM Writing Rules, on page B-4

• Check Regional, Date/Time, and Time Zone settings

 Note:
If an error dialog box appears during these sequences, see Chapter 3. Troubleshooting. 

Changing the Default PAP Unit Name
Request the Customer to change the default PAP unit name <PAP> from the  Microsoft
Windows Network configuration utility.

To change the default PAP unit name:

5. From the Microsoft Windows desktop, select:
MyComputer → Properties → Network Identification → Properties.

6. Complete the fields as required.

Launching the PAP Configuration Setup Wizard
To complete PAP unit configuration:

1. Request the Customer to provide the Installation Setup Data listed in the Read Me First
booklet enclosed in the Open Me First kit.

2. Open a new Microsoft Windows session with the predefined User Name and Password.

User Name Administrator

Password administrator

3. From the Microsoft Windows desktop, click:
Start → Program Files → Platform Administration and Maintenance → PAP
Configuration
to launch the PAP configuration setup wizard which guides you through the PAP Unit
configuration procedure (approximately 10 minutes).

The PAP configuration setup wizard dialog opens.

Figure 65. PAP configuration wizard dialog
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4. Click the Check PAM Release Type button. The Release Type dialog opens.

Figure 66. Release type dialog

 Note:
If the release type is not correct, select the required release type and click Apply change.

5. Check that the MultiDomain radio button is highlighted and click Back to PAP
Configuration to customize the PAP unit with the Installation Setup Data supplied by the
Customer:

– Click the Configure the Network button to configure Customer Enterprise LAN
settings and to change the default factory PAP unit network setting.

– Click the Change Windows Administrator Password button to change the PAP unit
Customer Administrator password.

– Click Configure PAM Software via the PAM Web Site to open a Support
Administrator PAM session to complete Customer Information, Autocalls and
Central Subsystem configuration.

 Warning: 
Changes to Central Subsystem configuration are hazardous and must not be
performed until the server has been fully tested. 
If the Customer wants to rename the Central Subsystem, this entails removing
the existing Central Subsystem and adding a new Central Subsystem with the
required name. 
Default Domain Schemes will not be applicable to the new Central Subsystem
and must be redefined. 
See Configuring the Central Subsystem, on page 2-53.
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Configuring Customer Information
Customer information is used by PAM software for the PAM Tree display and to complete
Intervention Reports.

To configure Customer information:

 Note:
If an error dialog box appears during this sequence, see Chapter 3. Troubleshooting. 

1. From the PAM Tree, click Configuration Tasks → Customer Information. The
Customer Information configuration page opens.

2. Enter Customer data and click Save to confirm changes.

Figure 67. Customer Information configuration page

 Notes:

The value entered in the Site name field is used for the PAM Tree root node. The default
name is NovaScale.

The values entered in the other fields can be consulted by the Customer and / or Support
personnel.
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Configuring Autocalls
The Autocall feature is part of the BULL Remote Maintenance contract. It is used to
automatically route system events to the Remote Maintenance Center. Full details are given
in the BULL Remote Maintenance Guide.

If the Customer’s maintenance contract includes the Autocall feature, configure Autocall
parameters as follows:

 Note:
If an error dialog box appears during this sequence, see Chapter 3. Troubleshooting. 

1. Click Configuration Tasks → Autocalls. The Autocalls configuration page opens.

Figure 68. Autocalls Channel Settings control pane

2. Select the Enable Autocalls checkbox.

3. Select the the Send Heartbeat checkbox and enter a value “in days” for the autocall
channel control in the Period box. Recommended value = 1.

4. Select the autocall dispatch mode :

– Local dispatch mode (default mode) sends autocalls to the local target directory
indicated under Local Settings,

– FTP dispatch mode sends autocalls to the server indicated under FTP Settings.

5. If Local dispatch mode (default mode) is selected, complete the Local Settings field
with the following information:

Field Explanation Value

Local target directory Default GTS directory used to store autocalls. c:\gts\session
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6. If FTP dispatch mode is selected, complete the FTP Settings fields with the following
information:

Field Explanation Value

Server name Remote Maintenance Center server IP address 127.0.0.1

Server port Default server port 21

Target directory Default server directory /autocall

Login Declared authorized user name X

Password Declared authorized user password X

7. If a modem connection is to be used:

a. From the PAP Unit Microsoft Windows desktop, configure the dial–up connection
(Control Panel → Phone and Modem Options).

b. From the PAM Autocalls Control Pane, select the Use modem connection
checkbox.

c. Use the Connection name drop–down menu to select the required modem
connection.

d. Complete the User name and Password fields with the declared authorized user
name and user password.

8. Return to the PAP Unit Microsoft Windows desktop to complete remote maintenance
setup as explained in the BULL Remote Maintenance Guide.

 Note:
Connection of the USB modem required for the Autocall feature is explained in Connecting
the USB Modem and External Devices, on page 2-51.



2-34 Installation Guide

Changing the iStorage Manager User Name and Password
FDA 1300 FC and FDA 2300 FC subsystems are delivered with iStorage Manager (iSM) for
integrated monitoring and centralized management.

The iSM Server / Client utility is installed on the PAP Unit desktop. The Customer can install
iSM Client on any standard PC running under Microsoft Windows (2000 or later).

Before using iSM, the Customer is advised to replace the factory default User Name and
Password.

To change the iStorage Manager User Name and Password:

1. From the PAP Unit Microsoft Windows desktop, click:
Start → Programs → NEC Storage Manager Server → Setting Utility.

2. Select the Users tab. The default User Name and User Level is displayed in the User
List.

Default User Name Administrator

Default User Level L3

Default Password administrator

3. Select Administrator from the User List and click Edit to open the User – Edit dialog
box.

4. Change the User Name and Password and check that the L3 radio button is highlighted.

5. Click OK.

6. A dialog box requests you to restart iSM to apply changes. Click Yes.

7. From the PAP Unit Microsoft Windows desktop, click:
Start → Programs → Administrative Tools → Services.

8. Select NEC Storage Manager → Action → Stop to stop iSM.

9. Click Action → Start to restart iSM. Changes are applied.
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Connecting the PAP Unit to the Customer’s Enterprise LAN

 CAUTION:
Remote access via the Web is a potential security hazard. Customers are strongly
advised to protect their systems with up–to–date protection devices such as
virus–prevention programs and firewalls, and to maintain a detailed record of
authorized users.

Once PAP unit configuration is complete, it can be connected to the Customer’s Enterprise
LAN.

The PAP unit provides two RJ45 Ethernet ports. The first is used for the internal server
network and the second for connection to the Customer’s Enterprise LAN for remote
platform administration and maintenance.

1. Open the rear door and remove the left side cover.
See Removing Side Covers, on page 1-14.

2. Guide the Enterprise network cable supplied by the Customer through the cable cut–out
at the base of the cabinet and up through the free space on the left side of the cabinet.

3. Access the PAP unit  RJ45 Ethernet ports from the rear of the cabinet.

Figure 69. PAP unit free Ethernet port

4. Secure the Enterprise network cable to the left flange of the cabinet with the velcro
fasteners supplied in the Open Me First kit.

5. Close the rear door and refit the left side cover. See Refitting Side Covers, on page 1-26.

  Important: 
If the PAP unit is not connected to the Customer’s Enterprise LAN, event messaging
systems will not be enabled.
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Connecting to the PAM Web Site from a Remote
Computer/Workstation

  Important: 
For optimum security, before connecting to PAM from a remote computer, you are
advised to disconnect from your local Windows session on the PAP unit by clicking
Start → Log Off.

The PAM Software utility can be accessed from any PC running Microsoft Windows with the
Internet Explorer (6 or later) browser installed and/or from any workstation running Linux
with the Mozilla (1.6 or later) browser installed.

 Notes:
PAM Configuration Tasks and Servicing Tools can only be accessed from the
local/integrated console or from a remote computer running Microsoft Windows with the
Internet Explorer browser installed.
PAP unit setup is described in Completing PAP Unit Configuration, on page 2-29.

Enabling Remote Access to the PAM Web Site with Internet Explorer
1. From the remote computer, configure Internet Explorer to connect directly to the PAM

Web site:

a. From the Internet Explorer main menu bar, select Tools → Internet Options →
Home Page.

b. Type the PAM Web site URL defined during the PAP installation procedure in the
home page address field: http://<PAPname>/pam
(where <PAPname> is the name allocated to PAP unit during setup).

c. Save your changes and close Internet Explorer.
2. Launch Internet Explorer to connect directly to the PAM web site.

3. When prompted, enter the appropriate Administrator or Operator User Name and
Password. The PAM home page appears.

Enabling Remote Access to the PAM Web Site with Mozilla
1. From the remote computer, configure Mozilla to connect directly to the PAM Web site:

a. From the Mozilla main menu bar, select Edit → Preferences → Navigator.
b. Check the Home Page box and enter the PAM Web site URL defined during the PAP

installation procedure in the location field:
http://<PAPname>/pam
(where <PAPname> is the name allocated to PAP unit during setup).

c. Save your changes and close Mozilla.
2. Launch Mozilla to connect directly to the PAM web site.

3. When prompted, enter the appropriate Administrator or Operator User Name and
Password. The PAM home page appears.
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Enabling Remote Access to iSM on the Client Computer
FDA 1300 FC and FDA 2300 FC subsystems are delivered with iStorage Manager (iSM) for
integrated monitoring and centralized management.

The iSM Server / Client utility is installed on the PAP Unit desktop. The Customer can install
iSM Client on any standard PC running under Microsoft Windows (2000 or later).

To enable remote access to iSM:

1. Insert the iSM Client setup CD–Rom in the client computer.

2. Run the CLIENT\2000\ISMCE211.EXE program to launch the setup wizard which guides
you through the iSM Client configuration procedure.

3. When you are requested to select Setup Type, click basic + extended function →
Next.

4. Once setup is complete, launch iSM Client to connect to iSM Server. A dialog box
appears requesting you to set the environment for iSM Client.

5. From the iSM Client menu, click File → Environment Settings to open the Server
Settings page.

6. In the IP Address field, enter the PAP unit IP address allocated during the PAP unit
setup process. See Completing PAP Unit Configuration, on page 2-29.

7. Click OK to establish the connection.

8. When requested enter the User Name and Password and click OK. See Changing the
iStorage Manager User Name and Password, on page 2-34.
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Completing Operating System Setup
A list of the Customer data required to complete setup is given in the Read Me First booklet
delivered with the system 24 hours before the scheduled installation date.

 Note:
For further information about the server booting environment, see Using EFI Utilities in the
User’s Guide.

To complete Operating System setup, see:

• NovaScale 6080/6160 Server – Operating System Setup, on page 2-39

• NovaScale 6320 Server – Operating System Setup, on page 2-43
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NovaScale 6080/6160 Server – Operating System Setup
An Operating System instance is pre–installed on each domain boot disk (EFI LUN):

0LU0 = LUN device connected to Module0, IOB0

0LU1 = LUN device connected to Module0, IOB1

According to Customer requirements, identical or different Operating System instances may
be pre–installed on each EFI LUN. Operating System setup must be completed for each
Operating System instance.

Before proceeding to complete setup on each domain:

1. From the Customer Administrator PAM Tree, click Domain Manager. 
MyOperations–1 and MyOperations–2 domains are displayed in the Control pane.

2. Check Operating System type for each domain:

Microsoft Windows or Linux  logo in the Domain Identities box.

3. Locate the corresponding DVD–Rom drive:

MyOperations–1: Module0, IOB0

MyOperations–2: Module0, IOB1

4. Note KVM ports for each domain:

MyOperations–1: CSS0–Mod0–IO0

MyOperations–2: CSS0–Mod0–IO1

5. Check that the Customer has supplied the System and Networking data required to
complete setup and customize the system. See the Installation Setup Data tables in the
Read Me First document supplied on delivery.

To complete Operating System setup, see:

• Microsoft Windows Setup, on page 2-40

• Linux Redhat Setup, on page 2-41

• Linux SuSe Setup, on page 2-42
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 Microsoft Windows Setup

 Warning: 
Most of the options selected and validated during the setup sequence can be
modified. However, special attention is to be paid when selecting and validating the
Licensing Mode (Per Seat / Per Server). If selected and validated, the “Per Server”
Licensing Mode option CAN be modified. If selected and validated, the “Per Seat”
Licensing Mode CANNOT be modified.

1. Check that the Microsoft Windows CD–Rom labeled “TO BE COMPLETED” is ready for
use and that the yellow sticker with the 25–character Microsoft Windows Product Key
required to complete setup is clearly visible inside the cabinet.

2. Select the first Microsoft Windows domain in the Control pane and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 display, as required. See Toggling the Local / Integrated Console
Display, on page 2-20.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Microsoft Windows CD–Rom in the corresponding DIB drive. The setup wizard
is launched automatically and guides the Customer and the Customer Service Engineer
through the setup completion procedure (approximately 30 minutes).

Once setup is complete, Microsoft Windows shuts down, the system domain is rebooted
and the server configuration wizard is launched automatically.

 Note:
Server configuration is a Customer–specific task and is not performed by the Customer
Service Engineer during installation. Once the system has been fully installed, the Customer
Administrator may launch this wizard to configure and manage Server Roles.

6. Close the server configuration wizard.

7. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

8. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-20.

9. Update Domain Identity Management Parameters:

a. From the Customer Administrator PAM Tree, click Domains → Identities.
b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog

opens.
c. Complete the Network Name, IP Address, and URL fields with the data entered

during the setup completion procedure.
10.Repeat steps 3 to 9 for each pre–installed Microsoft Windows instance.
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Linux  RedHat Setup
1. Select the first Linux RedHat domain in the Control pane scheme and click Power On to

power up the domain and associated hardware components.

2. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 display, as required. See Toggling the Local / Integrated Console
Display, on page 2-20.

3. Check Regional, Date/Time, and Time Zone settings.

4. Place the Linux RedHat CD–Rom in the corresponding DIB drive. Setup is completed via
the Webmin administration tool:

a. Enter the Webmin URL:
http://<localhost>:10000. The Login to Webmin dialog box opens.

b. Enter the default User Name and Password, followed by Enter. The Webmin home
page opens.

User Name root

Password root

c. Click the Networking icon to open the Networking main page.
d. Click Network Configuration → Network Interfaces. In the Interfaces Activated at

Boot Time field, click Add a new interface to open the Create Bootup Interface
configuration page. Complete the required fields with the data supplied by the
Customer and click Create.

e. From the Interfaces Activated at Boot Time field, select the new interface. The Edit
Bootup Interface page opens. Check settings and click Save and Apply → Return
to network configuration.

f. Click Routing and Gateways to open the Routing and Gateways configuration
page. Complete the required fields with the data supplied by the Customer and click
Save → Return to network configuration.

g. Click DNS Client to open the DNS Client Options configuration page. Complete the
required fields with the data supplied by the Customer and click Save → Return to
network configuration.

h. Click Host Addresses → Add a new host address to open the Host and
Addresses configuration box. Complete the required fields with the data supplied by
the Customer and click Create → Return to host addresses list → Return to
network configuration → Return to index → System → Bootup and Shutdown to
create a new bootup and shutdown action.

i. From the action list, select Network to display the Edit Action page and click →
Restart Now → Return to action → Return to bootup and shutdown actions →
Return to index → Log Out to exit Webmin. Once setup is complete, the network is
activated.

5. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

6. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-20.

7. Update Domain Identity Management Parameters:

a. From the Customer Administrator PAM Tree, click Domains → Identities.
b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog

opens.
c. Complete the Network Name, IP Address, and URL fields with the data entered

during the setup completion procedure.
8. Repeat steps 1 to 7 for each pre–installed Linux Redhat instance.
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Linux  SuSe Setup
1. Select the first Linux SuSe domain in the Control pane scheme and click Power On to

power up the domain and associated hardware components.

2. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 display, as required. See Toggling the Local / Integrated Console
Display, on page 2-20.

3. Check Regional, Date/Time, and Time Zone settings.

4. Place the Linux SuSe CD–Rom in the corresponding drive. Setup is completed via the
Yast Control Center administration tool:

a. Type the default User Name and Password, followed by Enter.

User Name root

Password root

b. Enter yast2 (graphical mode) or yast (non–graphical mode) to open the Yast Control
Center main page.

 Note:
Use the <Tab> and <Arrow> keys to navigate through the menus.

c. Click Network/Basic → Network Card Configuration.
d. Select the required network card and click Configure.
e. From the Network Address Setup page, select the setup method and complete the

required fields with the data supplied by the Customer.
f. From the Details settings area, click Host name and name server. Complete the

required fields and click Next.
g. From the Details settings area, click Routing. Complete the required fields and click

Next to return to the Network Card Configuration page. Your network card is
displayed in the Already configured devices area.

h. Click Close to exit Yast Control Center. Once setup is complete, the network is
activated.

5. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

6. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-20.

7. Update Domain Identity Management Parameters:

a. From the Customer Administrator PAM Tree, click Domains → Identities.
b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog

opens.
c. Complete the Network Name, IP Address, and URL fields with the data entered

during the setup completion procedure.
8. Repeat steps 1 to 7 for each pre–installed Linux SuSE instance.
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NovaScale 6320 Server – Operating System Setup
An Operating System instance is pre–installed on each domain boot disk (EFI LUN):

0LU0 = LUN device connected to Module0, IOB0

0LU1 = LUN device connected to Module0, IOB1

0LU2 = LUN device connected to Module1, IOB0

0LU3 = LUN device connected to Module1, IOB1

According to Customer requirements, identical or different Operating System instances may
be pre–installed on each EFI LUN. Operating System setup must be completed for each
Operating System instance.

Before proceeding to complete setup on each domain:

1. From the Customer Administrator PAM Tree, click Domain Manager. 
MyOperations–1and MyOperations–2, MyOperations–3 and MyOperations–4
domains are displayed in the Control pane.

2. Check Operating System type for each domain:

Microsoft Windows or Linux  logo in the Domain Identities box.

3. Locate the corresponding CD–Rom drive:

MyOperations–1: Module0, IOB0

MyOperations–2: Module0, IOB1

MyOperations–3: Module1, IOB0

MyOperations–4: Module1, IOB1

4. Note KVM ports for each domain:

MyOperations–1: CSS0_Mod0_IO0

MyOperations–2: CSS0_Mod0_IO1

MyOperations–3: CSS0_Mod1_IO0

MyOperations–4: CSS0_Mod1_IO1

5. Check that the Customer has supplied the System and Networking data required to
complete setup and customize the system. See the Installation Setup Data tables in the
Read Me First document supplied on delivery.

To complete Operating System setup, see:

• Microsoft Windows Setup, on page 2-44

• Linux Redhat Setup, on page 2-45

• Linux SuSe Setup, on page 2-46
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Microsoft Windows Setup

 Warning: 
Most of the options selected and validated during the setup sequence can be
modified. However, special attention is to be paid when selecting and validating the
Licensing Mode (Per Seat / Per Server). If selected and validated, the “Per Server”
Licensing Mode option CAN be modified. If selected and validated, the “Per Seat”
Licensing Mode CANNOT be modified.

1. Check that the Microsoft Windows CD–Rom labeled “TO BE COMPLETED” is ready for
use and that the yellow sticker with the 25–character Microsoft Windows Product Key
required to complete setup is clearly visible inside the cabinet.

2. SCSI Disk Racks
Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance. 
See Preparing SCSI Disk Racks, on page 2-48.
FC Disk Racks
No action.

3. Select the first Microsoft Windows domain in the Control pane and click Power On to
power up the domain and associated hardware components.

4. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or ,
MyOperations–2, MyOperations–3, or MyOperations–4 display, as required. See
Toggling the Local / Integrated Console Display, on page 2-20.

5. Check Regional, Date/Time, and Time Zone settings.

6. Place the Microsoft Windows CD–Rom in the corresponding drive. The setup wizard is
launched automatically and guides the Customer and the Customer Service Engineer
through the setup completion procedure (approximately 30 minutes).

Once setup is complete, Microsoft Windows shuts down, the system domain is rebooted
and the server configuration wizard is launched automatically.

 Note:
Server configuration is a Customer–specific task and is not performed by the Customer
Service Engineer during installation. Once the system has been fully installed, the Customer
Administrator may launch this wizard to configure and manage Server Roles.

7. Close the server configuration wizard.

8. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

9. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-20.

10.Update Domain Identity Management Parameters:

a. From the Customer Administrator PAM Tree, click Domains → Identities.

b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog
opens.

c. Complete the Network Name, IP Address, and URL fields with the data entered
during the setup completion procedure.

11.SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.

12.Repeat steps 3 to 11 for each pre–installed Microsoft Windows instance.
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Linux  RedHat Setup
1. SCSI Disk Racks

Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance. See Preparing SCSI Disk Racks, on page
2-48.
FC Disk Racks
No action.

2. Select the first Linux RedHat domain in the Control pane scheme and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or ,
MyOperations–2, MyOperations–3, or MyOperations–4 display, as required. See
Toggling the Local / Integrated Console Display, on page 2-20.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Linux RedHat CD–Rom in the corresponding drive. Setup is completed via the
Webmin administration tool:

a. Enter the Webmin URL:
http://<localhost>:10000. The Login to Webmin dialog box opens.

b. Enter the default User Name and Password, followed by Enter. The Webmin home
page opens.

User Name root

Password root

c. Click the Networking icon to open the Networking main page.

d. Click Network Configuration → Network Interfaces. In the Interfaces Activated at
Boot Time field, click Add a new interface to open the Create Bootup Interface
configuration page. Complete the required fields with the data supplied by the
Customer and click Create.

e. From the Interfaces Activated at Boot Time field, select the new interface. The Edit
Bootup Interface page opens. Check settings and click Save and Apply → Return
to network configuration.

f. Click Routing and Gateways to open the Routing and Gateways configuration
page. Complete the required fields with the data supplied by the Customer and click
Save → Return to network configuration.

g. Click DNS Client to open the DNS Client Options configuration page. Complete the
required fields with the data supplied by the Customer and click Save → Return to
network configuration.

h. Click Host Addresses → Add a new host address to open the Host and
Addresses configuration box. Complete the required fields with the data supplied by
the Customer and click Create → Return to host addresses list → Return to
network configuration → Return to index → System → Bootup and Shutdown to
create a new bootup and shutdown action.

i. From the action list, select Network to display the Edit Action page and click →
Restart Now → Return to action → Return to bootup and shutdown actions →
Return to index → Log Out to exit Webmin. Once setup is complete, the network is
activated.

6. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

7. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-20.

8. Update Domain Identity Management Parameters:
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a. From the Customer Administrator PAM Tree, click Domains → Identities.

b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog
opens.

c. Complete the Network Name, IP Address, and URL fields with the data entered
during the setup completion procedure.

9. SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.

10.Repeat steps 1 to 9 for each pre–installed Linux Redhat instance.

Linux  SuSe Setup
1. SCSI Disk Racks

Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance. See Preparing SCSI Disk Racks, on page
2-48.
FC Disk Racks
No action.

2. Select the first Linux SuSe domain in the Control pane scheme and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or ,
MyOperations–2, MyOperations–3, or MyOperations–4 display, as required. See
Toggling the Local / Integrated Console Display, on page 2-20.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Linux SuSe CD–Rom in the corresponding drive. Setup is completed via the
Yast Control Center administration tool:

a. Type the default User Name and Password, followed by Enter.

User Name root

Password root

b. Enter yast2 (graphical mode) or yast (non–graphical mode) to open the Yast Control
Center main page.

 Note:
Use the <Tab> and <Arrow> keys to navigate through the menus.

c. Click Network/Basic → Network Card Configuration.

d. Select the required network card and click Configure.

e. From the Network Address Setup page, select the setup method and complete the
required fields with the data supplied by the Customer.

f. From the Details settings area, click Host name and name server. Complete the
required fields and click Next.

g. From the Details settings area, click Routing. Complete the required fields and click
Next to return to the Network Card Configuration page. Your network card is
displayed in the Already configured devices area.

h. Click Close to exit Yast Control Center. Once setup is complete, the network is
activated.

6. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

7. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-20.

8. Update Domain Identity Management Parameters:
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a. From the Customer Administrator PAM Tree, click Domains → Identities.

b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog
opens.

c. Complete the Network Name, IP Address, and URL fields with the data entered
during the setup completion procedure.

9. SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.

10.Repeat steps 1 to 9 for each pre–installed Linux SuSE instance.
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Preparing SCSI Disk Racks

  Important: 
Only the system / spare disks used by the current Operating System instance must
be accessible. Optional data disk drives must be unlocked, as shown in the following
figures.

SJ–0812 SCSI JBOD Disk Racks
Two domains share a disk rack with system and optional data disks. System and spare
disks are located in the same slots in each disk rack.

MyOperations–1 and MyOperations–2 share the same disk rack. MyOperations–1 is
connected to the SCSI HBA adapter located in Module0, IOB0, Slot 01 (Port A) and
MyOperations–2 is connected to the SCSI HBA adapter located in Module0, IOB1, Slot 01
(Port A).

MyOperations–3 and MyOperations–4 share the same disk rack. MyOperations–3 is
connected to the SCSI HBA adapter located in Module1, IOB0, Slot 01 (Port A) and
MyOperations–4 is connected to the SCSI HBA adapter located in Module1, IOB1, Slot 01
(Port A).

OS Disk Optional Data Disks
LEAVE

OS Disk
LEAVE

Spare Disk
LEAVE

Optional Data Disks

Spare Disk OS Disk

OS Disk
UNLOCK UNLOCKLEAVE

LEAVELEAVE

Figure 70. SJ–0812 SCSI JBOD disk racks – all domains
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SR–0812 SCSI RAID Disk Racks
Each domain has its own disk rack with system and optional data disks. System and spare
disks are located in the same slots in each disk rack.

MyOperations–1 disk rack is connected to the SCSI HBA adapter located in Module0,
IOB0, Slot 01 (Port A).

MyOperations–2 disk rack is connected to the SCSI HBA adapter located in Module0,
IOB1, Slot 01 (Port A).

MyOperations–3 disk rack is connected to the SCSI HBA adapter located in Module1,
IOB0, Slot 01 (Port A).

MyOperations–4 disk rack is connected to the SCSI HBA adapter located in Module1,
IOB1, Slot 01 (Port A).

OS Disk Optional Data Disks
LEAVE UNLOCK

OS Disk

LEAVE
Spare Disk

LEAVE
Optional Data Disks

UNLOCK

Figure 71. SR–0812 SCSI RAID disk racks – all domains

SJ–0812 SCSI Extension Disk Racks

Optional Data Disks

UNLOCK

Optional Data Disks

UNLOCK

Figure 72. SJ–0812 extension disk location (data) – All domains

Unlocking Disk Drives

1. Before proceeding to complete Operating System setup, use a Torx T10 screwdriver to
open the optional disk drive anti–tamper lock, the indicator becomes black.

2. Press the carrier latch to release the handle.

3. Wait 30 seconds.

Locking Disk Drives

1. Once Operating System setup is complete, use a Torx T10 screwdriver to close the
optional disk drive anti–tamper lock, the indicator becomes red.

2. Check drive LED status. If the lock is correctly closed, both LEDs should be lit.
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Connecting the Server to the Enterprise LAN

  Important: 
Extra cable lengths of 1.5  meters are required for maintenance. These extra cable
lengths must be absorbed in the plenum space under the cabinet.

At the Customer’s request, server domains server can be connected to the Enterprise LAN
for remote operation. The server offers two LAN connection options for each domain:

– via the IOR for a 10/100 Mb/s network,

– via an optional Gigabit Ethernet PCI adapter for a 1 Gb/s network.

Figure 73. 1Gb/s network connection

Figure 74. 10/100 Mb/s network connection

To connect server domain(s) to the Enterprise LAN:

NovaScale 6xx0 Servers

3. Locate the corresponding IOB / IOR network ports for each domain:

MyOperations–1: Module0, IOB0, IOR0

MyOperations–2: Module0, IOB1, IOR1

MyOperations–3 Module1, IOB0, IOR0

MyOperations–4: Module1, IOB1, IOR1

4. Connect the network cable equipped with an RJ45 connector to the IOR LAN port or to
the optional Gigabit Ethernet PCI adapter. Network connections are detected
automatically.

5. Carefully route network cables through the cable inlet at the base of the cabinet.
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Connecting the USB Modem and External Devices

Connecting the USB Modem
If the Customer’s maintenance contract includes the Autocall feature, connect the USB
modem as follows:

1. Connect the modem cable equipped with a USB connector to the USB port on the rear of
the PAP unit.

2. Route the line modem cable equipped with an RJ11 connector through the cable cut–out
at the base of the cabinet.

3. Connect the modem cable to the line port on the rear of the USB modem.
See Cabling Diagrams, on page C-1.See Cabling Diagrams, on page 0.

 Note:
Modem cable connectors differ from country to country. Customers are to provide the RJ11
adapter required to comply with national standards.

Connecting External Storage Peripherals
The Customer may now proceed to connect any external storage peripherals (tape libraries,
external disk subsystems, ...) required for use with the server.
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Testing Network Connections
Network connections to the PAP unit and to server domains can be tested from a remote
workstation connected to the same network by launching a PING command.

 Note:
PAP unit setup is described in Completing PAP Unit Configuration, on page 2-29.

Windows [  Workstation

1. Click Start → Run and enter cmd.

2. Enter ping <IP_address>, (where <IP_address> is the IP address allocated to the PAP
unit or server domain during setup).

Linux [  Workstation

1. Open a Shell command window.

2. Enter ping <IP_address>, (where <IP_address> is the IP address allocated to the PAP
unit or server domain during setup).

 Note:
If the PAP unit or server domain does not reply to the PING command, check network
connections and configuration:

– IP address,
– DHCP,
– Network mask,
– Network card driver.

Testing Autocalls
If the Customer’s maintenance contract includes the Autocall feature, check the connection
between the PAP unit and the Remote Maintenance Center Server as follows:

1. From the PAM home page, click Configuration Tasks → Autocalls.

2. Click the Test Autocall button in the toolbar. A dialog appears to confirm that the
autocall has been sent to the Remote Maintenance Center.

Completing the PAM Installation Intervention Report
Once system operation has been checked, an Installation Intervention Report must be
completed. If the Customer’s maintenance contract includes the Autocall feature, this report
will be automatically transferred to the Remote Maintenance Center.

 Note:
If the Customer’s maintenance contract does not include the Autocall feature, manually
complete the Installation Work Order provided in the Open Me First box. The intervention
report is sent as an event message and stored in the PAM History directory. See the User’s
Guide.

1. From the PAM home page, click Servicing Tools → Intervention Report.

2. Complete the Intervention Report.

3. Click Send.  If the Customer’s maintenance contract includes the Autocall feature, the
report is automatically transferred to the Remote Maintenance Center. If the Customer’s
maintenance contract does not include the Autocall feature, the report is sent as an
event message and stored in the PAM History directory.
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Renaming the Central Subsystem

 Note:
Central Subsystem configuration is reserved for Customer Service Engineers.

The Central Subsystem may be renamed to suit Customer requirements. Changes to
Central Subsystem configuration entail removing the existing Central Subsystem from the
configuration and adding a new Central Subsystem to the configuration with the name
chosen by the Customer.

  Important: 
Default Domain Schemes CANNOT be used by the new Central Subsystem and have
to be re–defined.
Default Domain Identities CAN still be used and do not have to be re–defined.

Removing / Adding the Central Subsystem
1. From the Support Administrator PAM Tree, click Domain Manager to check that all

domains are INACTIVE. If a domain is ACTIVE, request the Customer to power down
the domain. See Powering Up / Down Server Domains, on page 0.

2. Click Configuration Tasks → Central Subsystem. The Central Subsystem
management page opens.

3. Select the Central Subsystem and click Remove. A dialog opens requesting you to
confirm removal.

4. Click OK to remove the Central Subsystem.

5. Click New. The Add Central Subsystem dialog appears.

Figure 75. Central Subsystem configuration page
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6. Enter the Central Subsystem name supplied by the Customer and the hardware
hexadecimal identifier (between 0 and F as indicated on the PMB CSS code wheel).

Configuration
Cabinet Hexadecimal

Code (0 to F)
CSS Module 

Hexadecimal Code (0 to F)

NovaScale 6080/6160 Server 0 0

NovaScale 6320 Server 0
0

0 (module 0)
1 (module 1)

 Note:
If more than one server is present in the Customer’s configuration, increment cabinet
hexadecimal code position accordingly, e.g. Cabinet 1 = Position 0, Cabinet 2 = Position 1,
Cabinet 3 = Position 2, etc.

7. Click OK. You are requested to update the PAM tree.

8. Click the PAM tree  Refresh button. The new Central Subsystem is added to the
pool of resources available for domain management and configuration and appears in
the PAM tree under the Hardware Monitor node.

Central Subsystem

Functional status icon & CSS availability status bar

Figure 76. Central Subsystem node

9. Check server status – system functional status icon and CSS availability status bar
green in the Status pane. See Figure 56. Status pane, on page 2-18.

You must now redefine the default domain scheme, go to:

• Redefining the Default Scheme (NovaScale 6080/6160 Server), on page 2-55
or

• Redefining the Default Scheme (NovaScale 6320 Server), on page 2-58

 Note:
PAM software allocates a PUID (PAM Universal / Unique Identifier) to each hardware /
software object to guarantee unambiguous identification.

The PUID for a Central Subsystem is:
PAM:/CELLSBLOCK_<NAME>, 
where <NAME> is the name allocated by the Customer when the Central Subsystem is
declared.

The PUID for the Central Subsystem in the example shown above is:
PAM:/CELLSBLOCK_MYSERVER
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Redefining the Default Scheme (NovaScale 6080/6160 Server)

 Note:
In the screen shots used in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–1 and an instance of Linux is pre–installed on MyOperations–2.

1. From the Customer Administrator PAM Tree, click Configuration Tasks → Domains →
Schemes to open the Schemes Management pane.

2. Select MyOperationsScheme click Delete.

3. Click New to open the Scheme Creation dialog and complete the fields as follows:

Field Value

Scheme MyOperationsScheme

Description Default scheme for <MyServer>*

* <MyServer> = New Central Subsystem name given by the Customer

Figure 77. Scheme creation page
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4. Click Central Subsystem → Add to select the previously declared Central Subsystem.
The Central Subsystem Configuration dialog opens.

Figure 78. Central Subsystem Configuration dialog

5. Check that the Central Subsystem is highlighted and select 2 in the Number of Parts
dropdown list. Click OK to return to the Scheme Management dialog. Status icons are
red because a domain Identity is required to complete domain configuration.

Figure 79. Scheme Management dialog

6. Double click the empty D1 Identities field and select MyOperations–1 from the list of
available identities. The corresponding Status icon turns green.
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7. Double click the empty D2 Identities field and select MyOperations–2 from the list of
available identities. The corresponding Status icon turns green.

Figure 80. Scheme Management dialog

8. Click Save. The re–defined default domain scheme is now available for domain
management.

 Note:
For further details about domain configuration, see Configuring Domains in the User’s
Guide.
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Redefining the Default Scheme (NovaScale 6320 Server)

 Note:
In the screen shots used in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–1 and MyOperations–3 and an instance of Linux is pre–installed on
MyOperations–2 and MyOperations–4.

1. From the Customer Administrator PAM Tree, click Configuration Tasks → Domains →
Schemes to open the Schemes Management pane.

2. Select MyOperationsScheme click Delete.

3. Click New to open the Scheme Creation dialog and complete the fields as follows:

Field Value

Scheme MyOperationsScheme

Description Default scheme for <MyServer>*

* <MyServer> = New Central Subsystem name given by the Customer

Figure 81. Scheme creation page
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4. Click Central Subsystem → Add to select the previously declared Central Subsystem.
The Central Subsystem Configuration dialog opens.

Figure 82. Central Subsystem Configuration dialog

5. Check that the Central Subsystem is highlighted and select 4 in the Number of Parts
dropdown list.

6. Click OK to return to the Scheme Management dialog. Status icons are red because a
domain Identity is required to complete domain configuration.
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Figure 83. Scheme Management dialog

7. Double click the empty D1 Identities field and select MyOperations–1 from the list of
available identities. The corresponding Status icon turns green.

8. Repeat Step 7 for each empty Domain Identities field, taking care to select
MyOperations–2 for D2, MyOperations–3 for D3, MyOperations–4 for D4 from the list
of available identities. All the Status icons turn green.

Figure 84. Scheme Management dialog

9. Click Save. The re–defined default domain scheme is now available for domain
management.

 Note:
For further details about domain configuration, see Configuring Domains in the User’s
Guide.
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Setting up PAP Unit Users
The Customer Administrator should now set up at least one Customer Administrator and
one Customer Operator user account to ensure controlled access to the PAP unit.

The Microsoft Windows operating system pre–installed on the PAP unit provides standard
security features for controlling access to applications and resources. PAM software security
is based on Windows)  user management and you are advised to give Windows)

administrator rights to at least one member of the PAP Customer Administrator user group.
For further details about user management, refer to the Microsoft Windows documentation
on the Bull NovaScale Server System Resource CD.

 Note:
You are advised to change the temporary Administrator password (administrator) used for
setup purposes and to maintain a detailed record of authorized users.

Predefined PAP User Groups
For optimum security and flexibility, the Microsoft Windows software environment is
delivered with two predefined Customer user groups:

Pap_Customer_Administrators Group (CA)

This group is designed for customer representatives responsible for the overall
management, configuration, and operation of the system. Members of the Customer
Administrator group are allowed to configure and administrate the server and have full
access to the PAM Domain Manager, Hardware Monitor, History Manager and
Configuration Tasks menus, as shown in Table 7.

Pap_Customer_Operators (CO)

This group is designed for customer representatives responsible for the daily operation of
the system. Members of the Customer Operator group are allowed to operate the server
and have full access to the Domain Manager menu and partial access to the History
Manager menu, as shown in Table 7.

 Notes:

• Group membership also conditions which Event Messages a user will receive via the
PAM Web interface. See Setting up Event Subscriptions, in the User’s Guide.

• The two predefined Support user groups:

– Pap_Support_Administrators

– Pap_Support_Operators

are reserved EXCLUSIVELY for Customer Service Engineers responsible for monitoring,
servicing, and upgrading the system.

• The predefined Customer user groups have been designed to suit the needs of most
Administrator and Operators. Contact your Customer Service Engineer if you require a
customized user group.
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PAM Tools Associated Actions CA CO

Domain Manager

Load/delete domains

Power on/off/reset domains

View/modify domain settings

View domain status

View domain resources

View BIOS info

View BIOS version

View loaded BIOS image

View power logs

View request logs

Request a system dump

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

Hardware Monitor

View hardware functional/presence status

View detailed hardware status information

Use the hardware Search engine

Exclude/include hardware components

View current PAM Web site user information

View PAM version information

X

X

X

X

X

X

History Manager

View system history files and messages

Manually archive system history files

View/delete system history archives

View user history files

Manually archive user history files

View/delete user history archives

X

X

X

X

X

X

X

X

X

Configuration Tasks

View/modify customer information

Modify the system history automatic archiving policy

Create/modify/delete domain schemes and identities

Modify domain schemes and identities

Create/delete user histories

Modify user history automatic archiving policy

Customize the event messaging system

View/ modify PAM parameters

Display/modify autocall parameters

X

X

X

X

X

X

X

X

X

Status Pane

View/acknowledge WEB event messages

Check system functional status

Check CSS availability

X

X

X

X

X

X

Table 7. User access to PAM features

CA = Customer Administrator
CO = Customer Operator
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Backing Up and Restoring PAM Configuration Files
The Customer Administrator should now set up an automatic backup task via the Microsoft
Windows Task Scheduler to save PAM configuration data to a removable media or network
directory for rapid restoration in the event of a PAP unit failure.

PAM software can be deployed on any standard PC running the appropriate version of
Microsoft Windows and you can restore your configuration data to rebuild your working
environment.

PAM configuration data is automatically saved to the default PAM Site Data directory on the
PAP unit:

<WinDrive>:\Program Files\BULL\PAM\PAMSiteData\<DataCompatibilityRelease>

To ensure carefree, reliable and regular configuration data backup, the Bull NovaScale
Server Resource CD contains two scripts, PamBackupData.js and PamRestoreData.js,
that can be scheduled to run via the Microsoft Windows Task Scheduler.

 Note:
The PamBackupData.js and PamRestoreData.js scripts car also stored in the PAM Site
Data directory on the PAP unit:

<WinDrive>:\Program Files\BULL\PAM\PAMSiteData\ReleaseData\Utilities

 Warning: 
The same PAM software release must be deployed on the PAP unit and on the backup
PC to allow data restoration.
PAM releases use the same data directory to ensure configuration consistency.
Before activating / re–activating a PAM Version, ensure that the <Data Compatibility
Release> level of deployed releases is compatible.

Backing Up PAM Configuration Files
To create a Microsoft Windows automatic backup task:

1. Select or create the local or network directory to be used for saving configuration data,
e.g. <MyPamBackupDirectory>.

2. Create a local directory for the PamBackupData.js and PamRestoreData.js script files,
e.g. <MyPamBackupTools>.

3. Copy the PamBackupData.js and PamRestoreData.js script files into the
<MyPamBackupTools> directory.

4. Create a Text File and enter the following command line:

Cscript PamBackupData.js <MyPamBackupDirectory>

5. Save the Text File as a batch file with a .BAT extension,
e.g. <MyPamBackupCommand>.bat.

6. Click Control Panel → Scheduled Tasks →  Add Scheduled Task to open the Task
Scheduler wizard and follow the instructions. PAM configuration data will be
automatically saved at the interval indicated in the wizard.

 Note:
When requested to select  a program, select the <MyPamBackupCommand>.bat  batch
file.
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Restoring PAM Configuration Data
To restore PAM configuration data:

1. If required, install the same PAM software release on the backup PC as on the PAP unit.
See Deploying a New PAM Release, on page 0 and Activating a PAM Version, on page
0.

2. From the Microsoft Windows desktop, open a command window. Browse to the
<MyPamBackupTools> directory containing the script files and enter the following
command line:

Cscript PamRestoreBackupData.js <MyPamBackupDirectory>

Saved PAM configuration data is restored.



3-1Troubleshooting

Chapter 3. Troubleshooting

This chapter describes what to do if a problem occurs during installation. It includes the

following topics:

• Server power, on page 3-2

• Mouse, on page 3-3

• Keyboard, on page 3-4

• Monitor, on page 3-5

• KVM Switch, on page 3-6

• PAP Unit, on page 3-7

• Disk Rack, on page 3-8

• CD/DVD Drive, on page 3-9

• Operating System, on page 3-10

• PAM Software, on page 3-11



3-2 Installation Guide

Server Power

Problem Possible Cause Solution

The server does not power
up to standby.

The CSS module power cable is not
connected or is incorrectly
connected to the AC outlet.

Check the CSS module power cable
connection. Connect or reconnect the power
cable to the AC outlet.

The AC outlet is faulty. Try another AC outlet.

The AC source is missing. Call the site electrician to check the AC
source.

The AC power cable is faulty. Check the AC power cable for faults. Replace
the faulty cable.

The operating system does
not boot.

The disk rack power button is not set
to ON.

Check the power button on the rear of the
disk rack. Set to ON (I).

System disks are incorrectly inserted
in the disk rack.

Check system disk status LEDs. If the status
LEDs are not green, reinsert system disks.

The disk rack power cable is not
connected or is incorrectly
connected to the PDU.

Check the disk rack power cable connection.
Connect or reconnect the power cable to the
PDU.

The PDU power cable is not
connected or is incorrectly
connected to the AC outlet.

Check the PDU power cable connection.
Connect or reconnect the power cable to the
AC outlet.

The PDU circuit breaker is not ON. Check the PDU circuit breaker and turn ON if
required.

The AC outlet is faulty. Try another AC outlet.

The AC source is missing. Call the site electrician to check the AC
source.

Internal cables are not connected or
are incorrectly connected to their
dedicated ports.

Check data cable connections. Connect or
reconnect cables to their dedicated ports.

An internal cable is faulty. Check internal cables for faults. Replace the
faulty cable.

The server does not power
down (an activated domain
cannot be powered down).

Domain Operating System power
management settings do not allow
PAM software to power down the
domain.

Check domain Operating System power
management settings and change if required.
See User’s Guide.

The domain Operating System is not
responding.

Click Force Power OFF to shut down the
domain Operating System.

The PAM functional status
icon is not green.

See User’s Guide.

The PAM presence status
bar is not green.

See User’s Guide.
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Mouse

Problem Possible Cause Solution

The mouse does not move
the cursor or there is no
cursor on the screen.

The mouse signal has not been
reset.

Press the Control key twice to access the

Command Menu.
Enter the KVM Command Mode.:
Press and hold down the Num Lock key.
Press and release the (–) key.
Type MR (mouse reset).
Press the Enter key to accept and exit the
KVM Command Mode.

Internal cables are not connected or
are incorrectly connected to their
dedicated ports.

Check internal cable connections:
– Mouse to KVM,
– KVM to PAP,
– IOR to KVM. 
Connect or reconnect cables to their
dedicated ports.

The KVM switch power button is not
set to ON.

Check the power button on the rear of the

KVM switch. Set to ON (I).

The KVM switch power cable is not
connected or is incorrectly
connected to the PDU.

Check the KVM switch power cable

connection. Connect or reconnect the power

cable to the PDU.

The PDU power cable is not
connected or is incorrectly
connected to the AC outlet.

Check the PDU power cable connection.

Connect or reconnect the power cable to the

AC outlet.

The PDU circuit breaker is not ON. Check the PDU circuit breaker and turn ON if
required.

The AC outlet is faulty. Try another AC outlet.

The AC source is missing. Call the site electrician to check the AC

source.

An internal cable is faulty. Check internal cables for faults. Replace the
faulty cable.
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Keyboard

Problem Possible Cause Solution

The keyboard does not
function.

The KVM switch power button is not
set to ON.

Check the power button on the rear of the

KVM switch. Set to ON (I).

Internal cables are not connected or
are incorrectly connected to their
dedicated ports.

Check internal cable connections:
– Keyboard to KVM,
– KVM to PAP,
– IOR to KVM 
Connect or reconnect cables to their
dedicated ports.

The KVM switch power cable is not
connected or is incorrectly
connected to the PDU.

Check the KVM switch power cable

connection. Connect or reconnect the power

cable to the PDU.

The PDU power cable is not
connected or is incorrectly
connected to the AC outlet.

Check the PDU power cable connection.

Connect or reconnect the power cable to the

AC outlet.

The PDU circuit breaker is not ON. Check the PDU circuit breaker and turn ON if
required.

The AC outlet is faulty. Try another AC outlet.

The AC source is missing. Call the site electrician to check the AC

source.

An internal cable is faulty. Check internal cables for faults. Replace the
faulty cable.
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Monitor

Problem Possible Cause Solution

The monitor does not power
up (the status LED on the
monitor is not alight).

The monitor power button is not set
to ON.

Check that the power button on the front of
the monitor is ON.
Check that the vacation switch on the
right–hand side of the monitor is ON.
Turn the power button / vaction switch ON.

The monitor power cable is not
connected or is incorrectly
connected to the PDU.

Check the monitor power cable connection.

Connect or reconnect the power cable to the

PDU.

The PDU power cable is not
connected or is incorrectly
connected to the AC outlet.

Check the PDU power cable connection.
Connect or reconnect the power cable to the
AC outlet.

The PDU circuit breaker is not ON. Check the PDU circuit breaker and turn ON if
required.

The server is not powered up. Power up the server.

The AC outlet is faulty. Try another AC outlet.

The AC source is missing. Call the site electrician to check the AC

source.

The AC power cable is faulty. Check the AC power cable for faults. Replace
the faulty cable.

The status LED on the
monitor is alight but there is
no display on the screen.

The monitor contrast and / or
brightness settings are too low.

Use the buttons on the front of the monitor to
adjust contrast and / or brightness settings.

no display on the screen.
The KVM switch power cable is not
conected or is incorrectly connected
to the PDU.

Check the KVM switch power cable

connection. Connect or reconnect the power

cable to the PDU.

The KVM switch power button is not
set to ON.

Check the power button on the rear of the

KVM switch. Set to ON (I).

The KVM is not set to the correct
port (Port A – PAP, Port B –
Microsoft Windows, Port C – Linux).

Press the Control key twice to access the

Command Menu.
Select the required channel with the ↑↓�keys.
Press Enter to activate the selected channel
and exit the Command Mode.
If the KVM cannot be accessed or switched,
see KVM Switch on page 3-6.

Internal video cables are not
connected or are incorrectly
connected to their dedicated ports.

Check internal video cable connections:
– Monitor to KVM,
– KVM to PAP,
– IOR to KVM 
Connect or reconnect video cables to their
dedicated ports.

An internal cable is faulty. Check internal cables for faults. Replace the
faulty cable.
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KVM  Switch

Problem Possible Cause Solution

The green status / channel
LEDs on the front of the
KVM unit are not alight.

The KVM unit is not powered up. Check the power button on the rear of the
KVM unit. Turn to ON (I).

KVM unit are not alight.
The KVM unit power cable is not
connected or is incorrectly
connected to the PDU.

Check the KVM unit power cable connection.

Connect or reconnect the power cable to the

PDU.

The PDU power cable is not
connected or is incorrectly
connected to the AC outlet.

Check the PDU power cable connection.
Connect or reconnect the power cable to the
AC outlet.

The PDU circuit breaker is not ON. Check the PDU circuit breaker and turn ON if
required.

The AC outlet is faulty. Try another AC outlet.

The AC source is missing. Call the site electrician to check the AC

source.

The AC power cable is faulty. Check the AC power cable for faults. Replace
the faulty cable.

The status LED on the front

of the KVM unit is RED.

Internal unit failure. Replace the KVM.

The KVM cannot be

accessed or switched.

The KVM unit is in secure mode
(lock symbol on OSD screen).

If the KVM has been configured to the secure

mode, enter the password at the prompt.

Refer to the manufacturer’s documentation for

further information.

An internal cable is faulty. Check internal cables for faults. Replace the
faulty cable.
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PAP Unit

Problem Possible Cause Solution

The PAP unit does not
power up (the status LED on
the PAP unit is not alight).

The PAP unit power switch is not set
to ON.

Press the power button on the front of the
PAP unit .

the PAP unit is not alight).
BIOS settings are incorrect. Press F2 during the power–on sequence to

enter BIOS Setup.

1. Set the “After Power Failure” parameter to
“Power ON”.

2. Save Settings and Exit.

The PAP unit power cable is not
connected or is incorrectly
connected to the PDU.

Check the PAP unit power cable connection.

Connect or reconnect the power cable to the

PDU.

The PDU power cable is not
connected or is incorrectly
connected to the AC outlet.

Check the PDU power cable connection.
Connect or reconnect the power cable to the
AC outlet.

The PDU circuit breaker is not ON. Check the PDU circuit breaker and turn ON if
required.

The AC outlet is faulty. Try another AC outlet.

The AC source is missing. Call the site electrician to check the AC

source.

The AC power cable is faulty. Check the AC power cable for faults. Replace
the faulty cable.

POST is in progress. Wait a while. The status LED will turn green

once the POST is completed.

The status LED on the PAP
unit is alight but the PAP
unit does not boot.

Incorrect boot sequence. Press the reset button on the front of the PAP
unit.

The PAP unit does not boot. PAP unit disks are incorrectly
inserted.

Check disk status LEDs. If the status LEDs
are not green, reinsert the disks.

The PAP unit cannot be
accessed via the internal
network.

The LAN cable is not connected or
is incorrectly connected to the IOR
in the CSS module.

Check the PAP unit  LAN cable connection.
Connect or reconnect the LAN cable to the
IOR in the CSS module.

PAM software cannot be

launched.

The KVM switch is not set to the
correct port (Port A – PAP). The
green channel 1 (PAP) LED on the
front of the KVM switch is not alight
(another channel LED is alight).

Press the Control key twice to access the

KVM Command Menu, see Toggling the

Integrated Console , on page 2-20.
Select the PAP unit channel with the ↑↓�keys.

Press Enter to activate the PAP unit channel

and exit the Command Mode.

An internal cable is faulty. Check internal cables for faults. Replace the
faulty cable.
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Disk Rack

Problem Possible Cause Solution

The disk rack does not
power up (the power on and
power status LEDs on the

The disk rack power switch is not set
to ON.

Press the power button on the front of the disk
rack.

power status LEDs on the
disk rack are not alight). The disk rack power cable is not

connected or is incorrectly
connected to the PDU.

Check the disk rack power cable connection.

Connect or reconnect the power cable to the

PDU.

The PDU power cable is not
connected or is incorrectly
connected to the AC outlet.

Check the PDU power cable connection.
Connect or reconnect the power cable to the
AC outlet.

The PDU circuit breaker is not ON. Check the PDU circuit breaker and turn ON if
required.

The AC outlet is faulty. Try another AC outlet.

The AC source is missing. Call the site electrician to check the AC

source.

The disk rack is not
recognized by the server.

The interface cable(s) is (are) not
connected or is (are) incorrectly
connected to the HBA(s) in the CSS
module.

Check the disk rack interface cable
connection. Connect or reconnect the
interface cable(s) to the HBA(s) in the CSS
module.

An internal cable is faulty. Check internal cables for faults. Replace the
faulty cable.

The disk rack is not
recognized by the server.

Disk drives have not finished
spinning up.

Wait a while. The drive status LEDs will turn
green once they have finished spinning up.

Disk drives have not been correctly
installed.

Check that all disk drive cariers are correctly
installed.

The disk rack cannot be
accessed from the PAP unit.

The interface cable is not connected
or is incorrectly connected to the
COM port on the PAP unit.

Check the interface cable connection.
Connect or reconnect the interface cable to
the COM port on the PAP unit. Refer to the
manufacturer’s documentation for further
information.

An internal cable is faulty. Check internal cables for faults. Replace the
faulty cable.
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CD–ROM Drive

Problem Possible Cause Solution

The inserted CD cannot be
read.

The CD is faulty. Eject the CD. Check for visible faults. Reinsert
and try to read it again. If the CD still cannot
be read, try again with another CD. If the
problem persists, see Maintenance and
Service Guide.
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Operating System

Problem Possible Cause Solution

Microsoft Windows / Linux
does not start.

Incorrect EFI boot option. See Maintenance and Service Guide.

Microsoft Windows / Linux
does not respond.

Program run error. Reboot the server.

The server does not boot. System disks are incorrectly inserted
in the disk rack.

Check system disk status LEDs. If the status
LEDs are not green, reinsert system disks.

The server does not power
down (an activated domain
cannot be powered down).

Domain Operating System power
management settings do not allow
PAM software to power down the
domain.

Check domain Operating System power
management settings and change if required.
See User’s Guide.

The domain Operating System is not
responding.

Click Force Power OFF to shut down the
domain Operating System.
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PAM Software

Problem Possible Cause Solution

Internet Explorer does not
connect to the PAM Web
site.

The Maintenance LAN connection is
incorrectly configured.

Check maintenance LAN settings.
Configure or reconfigure if necessary:
IP address: 10.10.240.240
Subnet mask: 255.255.0.0
No DNS
No WINS

Refer to the Microsoft Windows
documentation for further information.

The server presence status
bar is RED, indicating that
the CSS Module has not
been detected.

The PMB is not connected or is
incorrectly connected to the PAP
unit.

1.  Check the PMB to PAP unit internal
network cable connection. Connect or
reconnect the PMB to the PAP unit.

2. Check PAP unit network connection
configuration. From the PAP Windows
desktop, click Start → Settings →
Network and Dial–up Connection.

3. Click the Command Prompt icon in the
Windows Task Bar.

4. Enter  IPCONFIG to check IP address
configuration.

5. If the local PAP address: 10.10.240.240
does NOT appear in the table, check that
the PAP is not configured as a DNS
server.

6. Check that PMB code wheel position has
not been changed. Default position :
Cabinet 0 / Module 0. See PMB LEDs in
the Maintenance and Service Guide.

7. Check PMB LED status. See PMB LEDs
in the Maintenance and Service Guide.

8. Reset the PMB by pressing the Reset
button on the front of the PMB.  See PMB
LEDs in the Maintenance and Service
Guide.

The Schemes List is empty. The default Domain Scheme has
been deleted.

Create the default Domain Scheme with the

PAM Domain Scheme wizard. See User’s
Guide.
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Appendix A.  Specifications

NovaScale 6080/6160 Server Specifications
The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise

Dimensions / Weight

Unpacked Packed

Height: 177.5 cm (70 in) Height: 202 cm (79.5 in)Height: 177.5 cm (70 in)

Width:   65.0 cm (25.6 in)

Depth:  113 cm (44.5 in)

Height: 202 cm (79.5 in)

Width:   80.0 cm (31.5 in)

Depth:  127.5 cm (50.2 in)

Width:   65.0 cm (25.6 in)

Depth:  113 cm (44.5 in)

Weight: 510 kg (1122 lb)

Width:   80.0 cm (31.5 in)

Depth:  127.5 cm (50.2 in)

Weight: 550 kg (1210 lb)Weight: 510 kg (1122 lb) Weight: 550 kg (1210 lb)

Service Clearance

Front 150 cmFront

Rear

Side (left and right)

150 cm

100 cm

100 cm

Rear

Side (left and right)

100 cm

100 cm

Operating Limits

Dry bulb temperature range +15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)
Relative humidity (non–condensing)

° ° ° °
Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)Relative humidity (non–condensing)

Max. wet bulb temperature
35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)
Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+24°C   (+75.2°F)

0.019 kg water/kg dry air
Pressure / Elevation

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range +5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)Relative humidity (non–condensing)

Max. wet bulb temperature

5 to 95%  (Gradient 30%)

+28°C   (+75°F)Max. wet bulb temperature

Moisture  content

+28°C   (+75°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range –35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95% 
Gradient 30%/h

Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels
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Power Cables

AC (20A)

Cable type

Connector type

2 per cabinet

3 x 4mm� / AWG # 12 (US)

C22 Appliance Coupler

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
The PDU requires an extra cable length of 1.5 meters for connection inside the cabi-
net.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

29.5 A max. at 200 VAC input

3000 VA per full CSS module)
1500 VA (per PDU)

2700 W / 9250 BTU (per full CSS module)
1300 W / 4610 BTU (per PDU

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection

Mains power CSS module
Maximum inrush current

Mains power PDU

20A Curve C
210A / per quarter period

20A Curve C

Maximum inrush current

Mains power PDU
Maximum inrush current

210A / per quarter period

20A Curve C
210A / per quarter period

Table 8. NovaScale 6080/6160 Server specifications
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NovaScale 6320 Server Specifications
The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise

Dimensions / Weight

Unpacked Packed

Height: 177.5 cm (70 in)

Width:   65.0 cm (25.6 in)

Height: 202 cm (79.5 in)

Width:   80.0 cm (31.5 in)Width:   65.0 cm (25.6 in)

Depth:  113 cm (44.5 in)

Width:   80.0 cm (31.5 in)

Depth:  127.5 cm (50.2 in)Depth:  113 cm (44.5 in)

Weight:
Main cabinet: 590 kg (1300 lb)

Depth:  127.5 cm (50.2 in)

Weight:
Main cabinet: 630 kg (1390 lb)Main cabinet: 590 kg (1300 lb)

I/O cabinet: 300 kg  (661 lb)
Main cabinet: 630 kg (1390 lb)
I/O cabinet: 340 kg  (750 lb)

Service Clearance

Front 150 cmFront

Rear

150 cm

100 cmRear

Side (free side)

100 cm

100 cm

Operating Limits

Dry bulb temperature range +15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)
Relative humidity (non–condensing)

° ° ° °
Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)Relative humidity (non–condensing)

Max. wet bulb temperature
35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)
Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+24°C   (+75.2°F)

0.019 kg water/kg dry air
Pressure / Elevation

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range +5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)Relative humidity (non–condensing)

Max. wet bulb temperature

5 to 95%  (Gradient 30%)

+28°C   (+75°F)Max. wet bulb temperature

Moisture  content

+28°C   (+75°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range –35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95% 
Gradient 30%/h

Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels
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Power Cables

AC (20A)

Cable type

Connector type

Main cabinet: 2 (1 per CSS module)
I/O cabinet: 1 per PDU

3 x 4mm� / AWG # 12 (US)

C22 Appliance Coupler

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
The PDU requires an extra cable length of 1.5 meters for connection inside the cabi-
net.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

29.5 A max. at 200 VAC input

3000 VA per full CSS module)
1500 VA (per PDU)

2700 W / 9250 BTU (per full CSS module)
1300 W / 4610 BTU (per PDU)

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection

Mains power CSS module
Maximum inrush current

Mains power PDU

20A Curve C
210A / per quarter period

20A Curve C

Maximum inrush current

Mains power PDU
Maximum inrush current

210A / per quarter period

20A Curve C
210A / per quarter period

Table 9. NovaScale 6320 Server specifications
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Appendix B. Conversion, Keyboard, and Writing Tables

Imperial to Metric

1 inch (”) 2.54 cm (centimeters)

1 foot (’) (12 inches) 30.48 cm

1 yards (yd) (3 feet) 0.91 m (meters)

1 mile (mi) (1760 yards) 1.6093 km (kilometers)

1 pound (avdp) (lb) 0.5 kg (kilograms)

1 ounce (avdp) (oz) 28.4 g (grams)

1 square foot (ft2) 0.093 m2 (square meters)

1 square inch (in2) 6.5 cm2 (square centimeters)

1 square yard (yd2) 0.8 m2 (square meters)

1 acre 0.4 ha (hectares)

1 cubic foot (ft3) 0.03 m3 (cubic meters)

1 horsepower (hp) 0.7  kw (kilowatts)

1 lb/ft2 4.88 kg/m2

1 Btu 0.2929 w hour

Table 10. Imperial to metric conversion table

Metric to Imperial

1 meter (meter) 3.3’ (feet) / 1.09 yd (yards)

1 centimeter (cm) 0.3937” (inches)

1 kilometer (km) 0.62 mi (miles)

1 gram (g) 0.04 oz (ounces (avdp))

1 kilogram (kg) 2.2 lbs (pounds (avdp))

1 sq. centimeter (cm2) 0.15 in2 (square inches)

1 square meter (m2) 10.76  ft2 (square feet)

1 square meter (m2) 1.2 yd2 (square yards)

1 hectare (ha) 2.5 acres

1 cubic meters (m3) 35.3 ft3 (cubic feet)

1 kilowatts (kW) 1.3 hp (horsepower)

1 kg/m2 0.205 lb/ft2

1 kW hour 3412 Btu (British thermal unit)

Table 11. Metric to imperial conversion table
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Celsius to Fahrenheit Conversion
Multiply the temperature in Celsius by 9, divide by 5 and add 32:
(C� x 9/5) + 32 =  F�

Fahrenheit to Celsius Conversion
Subtract 32 degrees from the temperature in Fahrenheit, multiply by 5 and divide by 9:
(F� – 32) x 5/9 = C�
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AZERTY/QWERTY Keyboard Lookup Table

Figure 85. AZERTY keyboard

Figure 86. QWERTY keyboard
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PAM Writing Rules

Illegal Characters
The following table lists the illegal characters that must not be used in PAM identifiers.

Illegal Characters

à, é, è, ù, ^, ¨ Accentuated letters

/ Slash

\ Backslash

“ Double quote

’ Simple quote

‘ Inverted comma

& Ampersand

+ Plus

* Asterisk

% Percent

= Equal sign

< Less–than sign

> Greater–than sign

: Colon

! Exclamation mark

? Question mark

; Semi–colon

, Comma

~ Tilde

I Pipe operator

Space. Use – (dash) or _ (underscore)

Table 12. PAM illegal characters

String Lengths
The following table lists authorized string lengths.

String Type Length

CellBlock / System Name 16

Scheme Name 32

History Name 64

Archive Name 75 (History Name: + 11 (_JJMMAA_nnn)

LUN Name 32

Switch Name 32

Event Name 32

Description 256 (Scheme: unlimited)

Domain Identity Name 16

Table 13. String length rules
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Registry Keys
PAM obtains file paths via 2 registry keys:

• ReleaseRoot:
Contains PAP application file paths (DLL, WEB pages, models,...).
Two versions of PAM software can be installed and used indifferently on the same
machine: each new version is installed in a new directory.

• SiteRoot:
Contains site data file paths.
Site data remains valid when the PAM software version changes.

Registry keys are generally stored under:
HKEY_LOCAL_MACHINE\SOFTWARE\BULL\PAM
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Appendix C. Cabling Diagrams

This appendix contains illustrations to supplement server cabling procedures. It includes the
following sections:

• Section I – NovaScale 6080/6160 Server Cabling Diagrams, on page C-2

• Section II – NovaScale 6320 Server Cabling Diagrams, on page C-20
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Section I – NovaScale 6080/6160 Server Cabling Diagrams
 Console, on page C-3

 KVM Switch, on page C-4

 IOR, on page C-6

 PAP Unit, on page C-8

 Disk Rack (SJ–0812 SCSI JBOD), on page C-10

 Disk Rack (SR–0812 SCSI RAID), on page C-11

 Disk Rack (FDA 1300 FC), on page C-12

 Extension Disk Rack (FDA 1300 FC – FDA 1300 FC), on page C-13

 Disk Rack (FDA 2300 FC), on page C-14

 Extension Disk Rack (FDA 2300 FC – FDA 1300 FC), on page C-15

 PMB, on page C-16

 Ethernet Hub, on page C-17

 Modem, on page C-18

 Power, on page C-19
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Integrated Console

Slideaway Console

Mark Cable Type From To

1 video/PS2/PS2 cable Console (video) KVM switch (video)

2 PS2/USB converter Console (PS2/PS2) KVM switch (USB)

Figure 87. Slideaway console data cabling diagram

Console Drawer

Mark Cable Type From To

1 HD15 video cable Monitor
(blue)

KVM switch
(blue)

2 PS2 mini–DIN6 cable + PS2/PS2 extension cable Keyboard
(mauve)

KVM switch
(mauve)

3 PS2 mini–DIN6 cable + PS2/PS2 extension cable Mouse
(green)

KVM switch
(green)

Figure 88. Console drawer data cabling diagram
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KVM Switch

Aten 8–Port KVM Switch

Mark Cable Type From To

1 Video/PS2/PS2 cable Console (video) KVM switch (video)

2 PS2/USB converter Console (PS2/PS2) KVM switch (USB)

3 Combined PS2/VGA cable KVM Port 1 PAP (VGA/PS2)

4 Combined USB/VGA cable KVM Port 2 IOR (IOB0) (Video/USB)

5 Combined USB/VGA cable KVM Port 3 IOR (IOB1) (Video/USB)

Figure 89. 8–port KVM switch data cabling diagram (example 1)
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Avocent 8–Port KVM Switch

Mark Cable Type From To

1 HD15 video cable Monitor (blue) KVM
(blue)

2 PS2 mini–DIN6 cable + 
PS2/PS2 extension cable

Keyboard (mauve) KVM
(mauve)

3 PS2 mini–DIN6 cable + 
PS2/PS2 extension cable

Mouse (green) KVM
(green)

4 Combined PS2/VGA cable KVM Port A PAP VGA/PS2

10 Combined USB/VGA cable (Windows)

Combined PS2/VGA cable (Linux)

KVM Port C/D

KVM Port C/D

IOR Video/USB

IOR (Video)

11 USB/PS2 converter (Linux) PS2 cable (mark 10) IOR (USB)

Figure 90. 8–port KVM switch data cabling diagram (example 2)
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IOR

IOR – 2U PAP Unit – Aten 8–Port KVM Switch

Mark Cable Type From To

1 DB9 to DB9 cross cable PAP COM 2 IOR (IOB0)

2 DB9 to DB9 cross cable PAP COM 1 IOR (IOB1)

3 Combined USB/VGA cable KVM Port 2 IOR (IOB0) Video/USB

4 Combined USB/VGA cable KVM Port 3 IOR (IOB1) Video/USB

Figure 91. IOR data cabling diagram (example 1)
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IOR – 1U PAP Unit – Avocent 8–Port KVM Switch

Mark Cable Type From To

7 RJ45/DB9 to DB9 cross cable

DB9 to DB9 cross cable

PAP COM 2

PAP COM 1

IOR (IOB0)

IOR (IOB1)

10 Combined USB/VGA cable (Windows)

Combined PS2/VGA cable (Linux)

KVM Port C/D

KVM Port C/D

IOR Video/USB

IOR (Video)

11 USB/PS2 converter (Linux) PS2 cable (mark 10) IOR (USB)

Figure 92. IOR data cabling diagram (example 2)
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PAP Unit

2U PAP Unit

Mark Cable Type From To

1 DB9 to DB9 cross cable PAP COM 2 IOR (IOB0) COM2

2 DB9 to DB9 cross cable PAP COM 1 IOR (IOB1) COM2

3 RJ45 – RJ45 Ethernet cable PAP LAN Maint PMB or Hub

5 Combined PS2/VGA cable PAP VGA/PS2 KVM Port 1

6 RJ45 to RJ45 Ethernet cable PAP LAN Enter Enterprise LAN

7 USB cable PAP USB Modem

9 RJ11 – RJ11 cable Modem (Line) Telephone network socket

Figure 93. PAP unit data cabling diagram (example 1)
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1U PAP Unit

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable PMB Ethernet Hub port 8

2 RJ45 – RJ45 Ethernet cable PAP LAN Maint Hub port 7

4 Combined PS2/VGA cable PAP VGA/PS2 KVM Port A

5 RJ45 to RJ45 Ethernet cable PAP LAN Enter Enterprise LAN

7 RJ45/DB9 to DB9 cross cable

DB9 to DB9 cross cable

PAP COM 2

PAP COM 1

IOR (IOB0)

IOR (IOB1)

8 USB cable PAP USB Modem

9 RJ11 – RJ11 cable Modem (Line) Telephone network
socket

Figure 94. PAP unit data cabling diagram (example 2)
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Disk Rack (SJ–0812 SCSI JBOD)

Mark Cable Type From To

8* DB9 to Jack cable PAP COM 1 S/S Disk RS232

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI RAID S/S Disk Extension
port

* optional cable used to configure the disk S/S.

Figure 95. SJ–0812 SCSI JBOD disk rack data cabling diagram
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Disk Rack (SR–0812 SCSI RAID)

Mark Cable Type From To

8* DB9 to Jack cable PAP COM 1 or
Nport server

S/S Disk RS232

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI S/S Disk Host port

* optional cable used to configure the disk S/S.

Figure 96. SR–0812 SCSI RAID disk rack data cabling diagram

Extension Disk Rack (SR–0812 SCSI RAID – SJ–0812 SCSI JBOD)

Mark Cable Type From To

a9 SCSI–3 68–pin 
VHDCI to VHDCI cable

SR–0812 SCSI
RAID 
extension port

SJ–0812 SCSI JBOD 
extension port

Figure 97. SJ–0812 SCSI JBOD extension disk rack data cabling diagram
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Disk Rack (FDA 1300 FC)

Mark Cable Type From To

2 LC–LC cable S/S Disk (CTL 0) FC Adapter IOB 0

3 LC–LC cable S/S Disk (CTL 1) FC Adapter IOB 1

6 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 6

8 DB9 to DB9 serial cable * PAP COM 1 S/S Disk RS232

* optional cable used to configure the S/S disk.

Figure 98. FDA 1300 FC disk rack data cabling diagram
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Extension Disk Rack (FDA 1300 FC – FDA 1300 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 99. FDA 1300 FC – FDA 1300 FC extension disk rack data cabling diagram
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Disk Rack (FDA 2300 FC)

Mark Cable Type From To

2 LC–LC cable S/S Disk (CTL 0) FC Adapter IOB 0

3 LC–LC cable S/S Disk (CTL 1) FC Adapter IOB 1

6 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 6

8 DB9 to DB9 serial cable * PAP COM 1 S/S Disk RS232

* optional cable used to configure the S/S disk.

Figure 100. FDA 2300 FC disk rack data cabling diagram
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Extension Disk Rack (FDA 2300 FC – FDA 1300 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 101. FDA 2300 FC – FDA 1300 FC extension data cabling diagram
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PMB

1U PAP Unit

2U PAP Unit

Ethernet Hub

Mark Cable Type From To

6 RJ45 – RJ45 Ethernet cross cable PAP LAN Maint PMB Ethernet or Hub

Figure 102. PMB data cabling diagram examples
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Ethernet Hub

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable Hub Ethernet port 8 PMB Ethernet

2 RJ45 – RJ45 Ethernet cable Hub Ethernet port 7 PAP LAN Maint

3 RJ45 – RJ45 Ethernet cable Hub Ethernet port 6 S/S Disk

Figure 103. Ethernet hub data cabling diagram
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Modem

1U PAP Unit

2U PAP Unit

Mark Cable Type From To

Figure 104. Modem data cabling diagram
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Power
The CSS Module is equipped with a dedicated power supply cable. All other server
component power supply cables are connected to the internal PDU, as shown below:

Console Drawer

PAP Unit

Disk Rack 1

KVM Switch

Mains

Mains

1A

1A

8A

8A

8A

8A

8A

8A

Disk Rack 2

8

7

1

2

3

4

5
J8

J4

J3

J1

J7

J6

J5

J2

6

CSS Module

PDU

Power Bar

H

U
B

P1

9

Mark Cable Type From To

1 Power cable PAP PWR PDU J1

2 Power cable S/S Disk 1 PWR PDU J2

3 Power cable S/S Disk 1 PWR PDU J3

4 Power cable S/S Disk 2 PWR PDU J4

5 Power cable S/S Disk 2 PWR PDU J5

6 Power cable Power Bar PDU J6

7 Power cable KVM PWR PDU J7

8 Power cable Monitor PWR PDU J8

9 Power cable Hub PWR Power Bar P1

Figure 105. Power cabling diagram
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Section II – NovaScale 6320 Server Cabling Diagrams
 Console, on page C-21

 KVM Switch, on page C-23

 IOR, on page C-25

 PAP Unit, on page C-26

 Disk Rack (SJ–0812 SCSI JBOD), on page C-28

 Disk Rack (SR–0812 SCSI RAID), on page C-29

 Extension Disk Rack (SR–0812 SCSI RAID – SJ–0812 SCSI JBOD, on page C-30

 Disk Rack (FDA 1300 FC), on page C-31

 Extension Disk Rack (FDA 1300 FC – FDA 1300 FC), on page C-32

 Disk Rack (FDA 2300 FC), on page C-33

 Extension Disk Rack (FDA 2300 FC – FDA 1300 FC), on page C-34

 PMB – Hub – Pap Unit, on page C-35

 Ethernet Hub, on page C-36

 Modem, on page C-37

 Power, on page C-38

 Inter–Cabinet (PMB – Ethernet Hub), on page C-40

 Inter–Cabinet (IOR – KVM Switch), on page C-41

 Inter–Cabinet (IOB HBA RAID – SJ–0812 SCSI JBOD), on page C-42

 Inter–Cabinet (IOB HBA – SR–0812 SCSI RAID), on page C-43

 Inter–Cabinet (IOB HBA – FDA 1300 FC), on page C-43

 Inter–Cabinet (IOB HBA – FDA 2300 FC), on page C-44
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Console

Slideaway Console

Mark Cable Type From To

1 video/PS2/PS2 cable Console KVM switch

Figure 106. Slideaway console data cabling diagram
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Console Drawer

Mark Cable Type From To

1 HD15 video cable Monitor
(blue)

KVM switch
(blue)

2 PS2 mini–DIN6 cable + PS2/PS2 extension cable Keyboard
(mauve)

KVM switch
(mauve)

3 PS2 mini–DIN6 cable + PS2/PS2 extension cable Mouse
(green)

KVM switch
(green)

Figure 107. Integrated console data cabling diagram
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16–Port KVM Switch

Slideaway Console – 2U PAP Unit

Mark Cable Type From To

1 video/PS2/PS2 cable Console KVM switch

5 RJ45/RJ45 cable PAP (VGA and PS2) via AVRIQ (4) KVM Port 1

7* RJ45/RJ45 cable IOR #0 Module 0
VGA and USB via AVRIQ (6)

KVM Port 3

9* RJ45/RJ45 cable IOR #1  Module 0
VGA and USB via AVRIQ (8)

KVM Port 4

11* RJ45/RJ45 cable IOR #0 Module 1
VGA and USB via AVRIQ (10)

KVM Port 5

13* RJ45/RJ45 cable IOR #1  Module 1
VGA and USB via AVRIQ (12)

KVM Port 6

14 RJ45/RJ45 cable KVM (LAN) Enterprise LAN

* Inter–cabinet data cable

Figure 108. 16–port KVM switch data cabling diagram (example 1)
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Console Drawer – 1U PAP Unit

Mark Cable Type From To

1 HD15 video cable Monitor (blue) KVM (blue)

2 PS2 mini–DIN6 cable 
+ PS2/PS2 extension cable

Keyboard 
(mauve)

KVM
(mauve)

3 PS2 mini–DIN6 cable 
+ PS2/PS2 extension cable

Mouse 
(green)

KVM
(green)

5 RJ45/RJ45 cable PAP (VGA and PS2) via AVRIQ (4) KVM Port 1

7* RJ45/RJ45 cable IOR #0 Module 0
VGA and USB via AVRIQ (6)

KVM Port 3

9* RJ45/RJ45 cable IOR #1  Module 0
VGA and USB via AVRIQ (8)

KVM Port 4

11* RJ45/RJ45 cable IOR #0 Module 1
VGA and USB via AVRIQ (10)

KVM Port 5

13* RJ45/RJ45 cable IOR #1  Module 1

VGA and USB via AVRIQ (12)

KVM Port 6

14 RJ45/RJ45 cable KVM (LAN) Enterprise LAN

* Inter–cabinet data cable

Figure 109. 16–port KVM switch data cabling diagram (example 2)
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IOR

Mark Cable Type From To

7* RJ45/RJ45 cable IOR #0 Module 0
VGA and USB
via AVRIQ (6)

KVM Port 3

9* RJ45/RJ45 cable IOR #1  Module 0
VGA and USB
via AVRIQ (8)

KVM Port 4

11* RJ45/RJ45 cable IOR #0 Module 1
VGA and USB
via AVRIQ (10)

KVM Port 5

13* RJ45/RJ45 cable IOR #1  Module 1
VGA and USB
via AVRIQ (12)

KVM Port 6

* Inter–cabinet data cable

Figure 110. IOR data cabling diagram (16–port KVM switch)
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PAP Unit 

2U PAP Unit

Mark Cable Type From To

3 RJ45 – RJ45 Ethernet cable PAP (VGA and PS2)
via AVRIQ (4)

KVM Port 1

5 RJ45 – RJ45 Ethernet cable PAP Ethernet Hub Ethernet

6 RJ45 – RJ45 Ethernet cable PAP LAN Enter Enterprise LAN

7 USB cable PAP USB Modem USB

8 RJ11 – RJ11 cable Modem (Line) Telephone socket

* Inter–cabinet data cable

Figure 111. PAP unit (2U) data cabling diagram
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1U PAP Unit

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable PAP Ethernet Hub Ethernet port 1

2* RJ45 – RJ45 Ethernet cable PMB Module 0 Hub Ethernet port 2

3 RJ45 – RJ45 Ethernet cable PAP (VGA and PS2)
via AVRIQ (4)

KVM Port 1

5 RJ45 – RJ45 Ethernet cable PAP LAN Enter Enterprise LAN

6* RJ45 – RJ45 Ethernet cable PMB Module 1 Hub Ethernet port 3

7 USB cable PAP USB Modem USB

8 RJ11 – RJ11 cable Modem (Line) Telephone socket

9 # DB9 to DB9 serial cable * PAP COM 1 S/S Disk RS232

* Inter–cabinet data cable

# optional cable used to configure the disk S/S.

Figure 112. PAP unit (1U) data cabling diagram
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Disk Rack (SJ–0812 SCSI JBOD)

Mark Cable Type From To

8* DB9 to Jack cable PAP COM 1 S/S Disk RS232

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI RAID S/S Disk extension port

*optional cable used to configure the disk S/S.

Figure 113. SJ–0812 SCSI JBOD disk rack data cabling diagram
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Disk Rack (SR–0812 SCSI RAID)

Mark Cable Type From To

8* DB9 to Jack cable Nport server S/S Disk RS232

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI S/S Disk RAID Host
port

*optional cable used to configure the disk S/S.

Figure 114. SR–0812 SCSI RAID disk rack data cabling diagram
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Extension Disk Rack (SR–0812 SCSI RAID – SJ–0812 SCSI JBOD)

Mark Cable Type From To

a9 SCSI–3 68–pin 
VHDCI to VHDCI cable

SR–0812 SCSI
RAID 
extension port

SJ–0812 SCSI JBOD 
extension port

Figure 115. SJ–0812 SCSI JBOD extension disk rack data cabling diagram
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Disk Rack (FDA 1300 FC)

Mark Cable Type From To

2** LC–LC cable S/S Disk (CTL 0) FC Adapter IOB 0 Module 0

3** LC–LC cable S/S Disk (CTL 1) FC Adapter IOB 1 Module 0

4** LC–LC cable S/S Disk (CTL 0) FC Adapter IOB 0 Module 1

5** LC–LC cable S/S Disk (CTL 1) FC Adapter IOB 1 Module 1

6 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 6

7 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 7

8 * DB9 to DB9 serial cable PAP COM 1 S/S Disk RS232

* optional cable used to configure the S/S disk.

** Inter–cabinet data cable

Figure 116. FDA 1300 FC disk rack data cabling diagram
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Extension Disk Rack (FDA 1300 FC – FDA 1300 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 117. FDA 1300 FC – FDA 1300 FC extension disk rack data cabling diagram
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Disk Rack (FDA 2300 FC)

Mark Cable Type From To

2** LC–LC cable S/S Disk (CTL0–HF0) FC Adapter IOB 0 Module 0

3** LC–LC cable S/S Disk (CTL0–HF1) FC Adapter IOB 1 Module 0

4** LC–LC cable S/S Disk (CTL1–HF0) FC Adapter IOB 0 Module 1

5** LC–LC cable S/S Disk (CTL1–HF1) FC Adapter IOB 1 Module 1

6 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 6

8 * DB9 to DB9 serial cable PAP COM 1 S/S Disk RS232

* optional cable used to configure the S/S disk.

** Inter–cabinet data cable

Figure 118. FDA 2300 FC disk rack data cabling diagram
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Extension Disk Rack (FDA 2300 FC – FDA 1300 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 119. FDA 2300 FC – FDA 1300 FC extension data cabling diagram
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PMB

Mark Cable Type From To

2* RJ45 – RJ45 Ethernet cable PMB Ethernet Module 0 Hub port 2

6* RJ45 – RJ45 Ethernet cable PMB Ethernet Module 1 Hub port 3

* Inter–cabinet data cable

Figure 120. PMB  – Hub data cabling diagram



C-36 Installation Guide

Ethernet Hub

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable PAP Ethernet Hub port 1

2* RJ45 – RJ45 Ethernet cable PMB Ethernet Module 0 Hub port 2

6* RJ45 – RJ45 Ethernet cable PMB Ethernet Module 1 Hub port 3

9 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 6

* Inter–cabinet data cable

Figure 121. Ethernet hub data cabling diagram
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Modem

Mark Cable Type From To

Figure 122. Modem data cabling diagrams
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Power
The CSS Modules in the main cabinet are equipped with dedicated power supply cables. 
All other server component power supply cables (in the I/O cabinet) are connected to one or
two PDU(s), as shown below:

Main Cabinet

Mains

Mains

CSS 
Module 1

CSS 
Module 0

Figure 123. Main cabinet power cabling diagram

I/O Cabinet  – Standard Configuration

Console Drawer

KVM Switch

Mains

1A

1A

8A

8A

8A

8A

8A

8A

8

7

1

2

3

4

5

J8

J4

J3

J1

J7

J6

J5

J2

6

PDU

Hub

PAP Unit

SCSI 1 or FC 1 (PS1)

SCSI 2 or FC 1 (PS2)

SCSI 3 or FC 2 (PS1)

SCSI 4 or FC 2 (PS2)

Mark Cable Type From To

1 Power cable S/S Disk PWR PDU J1

2 Power cable S/S Disk PWR PDU J2

3 Power cable S/S Disk PWR PDU J3

4 Power cable S/S Disk PWR PDU J4

5 Power cable PAP PWR PDU J5

6 Power cable Hub PDU J6

7 Power cable KVM PWR PDU J7

8 Power cable Monitor PWR PDU J8

Figure 124. I/O cabinet power cabling diagram (standard)
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I/O Cabinet – Optional High Availability Configuration

Mains

SCSI 1 (PS1) or FC 1 (PS1)

1A

1A

8A

8A

8A

8A

8A

8A

J8

J4

J3

J1

J7

J6

J5

J2

PDU 1

1A

1A

8A

8A

8A

8A

8A

8A

J8

J4

J3

J1

J7

J6

J5

J2

PDU 2

Console Drawer

KVM Switch

SCSI 1 (PS2) or FC 1 (PS2)

SCSI 2 (PS1) or FC 2 (PS1)

SCSI 2 (PS2) or FC 2 (PS2)

SCSI 3 (PS1)

SCSI 3 (PS2)

SCSI 4 (PS1)

SCSI 4 (PS2)

Mains

Hub

PAP Unit

1

2

3

4

5

6

7

8

9

10

11

12

Mark Cable Type From To

1 Power cable S/S Disk PWR PDU1 J1

2 Power cable S/S Disk PWR PDU1 J2

3 Power cable S/S Disk PWR PDU1 J3

4 Power cable S/S Disk PWR PDU1 J4

5 Power cable KVM PWR PDU1 J7

6 Power cable Monitor PWR PDU1 J8

7 Power cable S/S Disk PWR PDU2 J1

8 Power cable S/S Disk PWR PDU2 J2

9 Power cable S/S Disk PWR PDU2 J3

10 Power cable S/S Disk PWR PDU2 J4

11 Power cable PAP PWR PDU2 J5

12 Power cable Hub PDU2 J6

Figure 125. Power cabling diagram
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Inter–Cabinet (PMB – Ethernet Hub)

Mark Cable Type From To

2 RJ45 – RJ45 Ethernet cable PMB Ethernet Module 0 Hub port 2

6 RJ45 – RJ45 Ethernet cable PMB Ethernet Module 1 Hub port 3

Figure 126. PMB  – Ethernet Hub inter–cabinet cabling diagram
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Inter–Cabinet (IOR – KVM Switch)

Mark Cable Type From To

7 RJ45/RJ45 cable IOR #0 Module 0
VGA and USB
via AVRIQ (6)

KVM Port 3

9 RJ45/RJ45 cable IOR #1  Module 0
VGA and USB
via AVRIQ (8)

KVM Port 4

11 RJ45/RJ45 cable IOR #0 Module 1
VGA and USB
via AVRIQ (10)

KVM Port 5

13 RJ45/RJ45 cable IOR #1  Module 1
VGA and USB
via AVRIQ (12)

KVM Port 6

Figure 127. IOR – 16–port KVM switch inter–cabinet cabling diagram
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Inter–Cabinet (IOB HBA RAID – SJ–0812 SCSI JBOD)

Mark Cable Type From To

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI S/S Disk Host port

Figure 128. IOB HBA RAID – SJ–0812 SCSI JBOD disk rack inter–cabinet cabling diagram
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Inter–Cabinet (IOB HBA – SR–0812 SCSI RAID)

Mark Cable Type From To

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI S/S Disk Host port

Figure 129. IOB HBA – SR–0812 SCSI RAID disk rack inter–cabinet cabling diagram

Inter–Cabinet (IOB HBA – FDA 1300 FC)

Mark Cable Type From To

2 LC–LC cable S/S Disk (CTL 0) FC Adapter IOB 0 Module 0

3 LC–LC cable S/S Disk (CTL 1) FC Adapter IOB 1 Module 0

4 LC–LC cable S/S Disk (CTL 0) FC Adapter IOB 0 Module 1

5 LC–LC cable S/S Disk (CTL 1) FC Adapter IOB 1 Module 1

Figure 130. IOB HBA – FDA 1300 FC disk rack inter–cabinet cabling diagram
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Inter–Cabinet (IOB HBA – FDA 2300 FC)

Mark Cable Type From To

2 LC–LC cable S/S Disk (CTL 0) FC Adapter IOB 0 Module 0

3 LC–LC cable S/S Disk (CTL 1) FC Adapter IOB 1 Module 0

4 LC–LC cable S/S Disk (CTL 0) FC Adapter IOB 0 Module 1

5 LC–LC cable S/S Disk (CTL 1) FC Adapter IOB 1 Module 1

Figure 131. FDA 2300 FC disk rack inter–cabinet data cabling diagram
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Glossary

A
AC: Alternating Current generated by the power
supply. See DC.

ACPI: Advanced Configuration and Power

Interface. An industry specification for the efficient
handling of power consumption in desktop and
mobile computers. ACPI specifies how a
computer’s BIOS, operating system, and peripheral
devices communicate with each other about power
usage.

Address: A label, name or number that identifies a
location in a computer memory.

AMI: American Megatrends Incorporated.

ANSI: American National Standards Institute.

API: Application Program Interface. The specific

method prescribed by a computer operating
system or by an application program by which a
programmer writing an application program can
make requests of the operating system or another
application.

Archive: (Archive file). A file that is a copy of a
history file. When a history file is archived, all
messages are removed from the history file.

ASCII: American National Standard Code for
Information Interchange. A standard number

assigned to each of the alphanumeric characters
and keyboard control code keys to enable the
transfer of information between different types of
computers and peripherals.

B
Backup: A copy of data for safe–keeping. The
data is copied form computer memory or disk to a
floppy disk, magnetic tape or other media.

Backup battery: The battery in a computer that
maintains real–time clock and configuration data
when power is removed.

Baud rate: The speed at which data is transmitted
during serial communication.

BIOS: Basic Input / Output System. A program

stored in flash EPROM or ROM that controls the
system startup process.

BIST: Built–In Self–Test. See POST.

Bit: Derived from BInary digiT. A bit is the smallest
unit of information a computer handles.

BTU: British Thermal Unit.

Byte: A group of eight binary digits (bit) long that
represents a letter, number, or typographic symbol.

C
Cache Memory: A very fast, limited portion of
RAM set aside for temporary storage of data for
direct access by the microprocessor.

CD-ROM: Compact DisK Read-Only Memory.
High-capacity read-only memory in the form of an

optically readable compact disk.

Cell: The smallest set of hardware components
allocated to a single OS. A cell is functionally
defined by:
– the number of available processors
– memory capacity
– I/O channel capacity.

CellBlock: A group of interconnected cells within a
single domain. See Central Subsystem.

Central Subsystem:  A group of interconnected
cells gathered within a single domain. See

CellBlock.

Chip: Synonym for integrated circuit. See IC.

Clipping: A PAM Event filter criterion. Clipping is
defined on a Count / Time basis aimed at routing a
pre–defined number of messages only. Identical
messages are counted and when the number of
messages indicated in the Count field is reached
within the period of time indicated in the Time field,
no other messages will be selected for routing.

CMC: Corrected Memory Check.

CMOS: Complementary Metal Oxide
Semiconductor. A type of low–power integrated

circuits. System startup parameters are stored in
CMOS memory. They can be changed via the
system setup utility.

COM: Component Object Model. Microsoft
technology for component based application
development under Windows.
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COM +: Component Object Model +.  Microsoft
technology for component based application
development under Windows. The external part of
the PAM software package is a COM+ application.

COM1 or COM2: The name assigned to a serial
port to set or change its address. See Serial Port.

Command: An instruction that directs the

computer to perform a specific operation.

Configuration: The way in which a computer is set
up to operate. Configurable options include CPU
speed, serial port designation, memory allocation,
...

Configuration Tasks: A PAM feature used to
configure and customize the server.

Control Pane: One of the three areas of the PAM
web page. When an item is selected in the PAM
Tree pane, details and related commands are
displayed in the Control pane. See PAM Tree pane

and Status pane.

Core Unit: A main CSS module unit
interconnecting the MIO, MQB, MSX and MFL
boards. See MIO, MQB, MSX, MFL.

COS: Cluster Operating System.

CPE: Corrected PCI Error.

CPU: Central Processing Unit. See
Microprocessor.

CSE: Customer Service Engineer.

CSS: Central Sub–System. See CellBlock.

CSS Module: A MidPlane with all its connected
components (QBBs, IO boards, PMB) and  utility
devices. See Module.

D
D2D: DC to DC converter.

DC: Direct Current generated by the power supply.
See AC.

Default Setting: The factory setting your server
uses unless instructed otherwise.

Density: The capacity of information (bytes) that

can be packed into a storage device.

Device Driver: A software program used by a
computer to recognize and operate hardware.

DIB: Device Interface Board. The DIB provides the
necessary electronics for the Internal Peripheral
Drawer. See IPD.

DIG64: Developer Interface Guide for IA64.

DIM Code: Device Initialization Manager. Initializes
different BUSes during the BIOS POST.

DIMM: Dual In-line Memory Module – the smallest
system memory component.

Disk Drive: A device that stores data on a hard or
floppy disk. A floppy disk drive requires a floppy
disk to be inserted. A hard disk drive has a

permanently encased hard disk.

DMA: Direct Memory Access. Allows data to be
sent directly from a component  (e.g. disk drive) to
the memory on the motherboard). The
microprocessor does not take part in data transfer
enhanced system performance.

DMI: Desktop Management Interface. An industry
framework for managing and keeping track of
hardware and software components in a system of
personal computers from a central location.

DNS: Domain Name Server. A server that retains

the addresses and routing information for TCP/IP
LAN users.

Domain: is the coherent set of resources allocated
to run a customer activity,  i.e. the association –at
boot time– of a Partition, an OS instance (including
applications) and associated LUNs and an
execution context including execution modes and
persistent information (e.g. time, date of the OS
instance). Domain definitions and initializations are

performed via PAM. A Domain can be modified to
run the same OS instance on a different Partition.
When a Domain is running,  its resources are
neither visible nor accessible to other running
Domains.

Domain Identity: a PAM Domain management
logical resource. This resource contains context
information related to the Customer activity running
in a domain. The most visible attribute of this
resource is the name that the Customer gives to

the activity. For each domain created, the Domain
management feature allows the operator to define
a new activity or choose an activity from the list of
existing activities. See Domain.

Domain Manager:  A PAM feature used to power
on / off and manage server domains. See Domain.

DPS: Distributed Power Supply.

DRAM: Dynamic Random Access Memory is the
most common type of random access memory
(RAM).



G-3Glossary

E
EEPROM: Electrically Erasable Programmable
Read-Only Memory. A type of memory device that

stores password and configuration data. See also
EPROM.

EFI: Extensible Firmware Interface.

EFIMTA: EFI Modular Test Architecture.

EFI Shell: The EFI (Extensible Firmware Interface)
Shell is a simple, interactive user interface that
allows EFI device drivers to be loaded, EFI
applications to be launched, and operating systems
to be booted. In addition, the EFI Shell provides a
set of basic commands used to manage files and
the system environment variables. See Shell.

EMI: Electro–Magnetic Interference.

EPROM: Erasable Programmable Read-Only
Memory. A type of memory device that is used to
store the system BIOS code. This code is not lost
when the computer is powered off.

ERC: Error Recovery Check.

ERP: Error Recovery Procedure.

ESD: ElectroStatic Discharge. An undesirable
discharge of static electricity that can damage
equipment and degrade electrical circuitry.

Event: The generation of a message (event
message) by a software component and that is
directed to the Event Manager.

Event address: Defines the destination for a

message sent over a specified event channel. An
address is one of: the name of a history file (for the
HISTORY channel), an e–mail address (for the
EMAIL channel), the name of a user group (for the
WEB channel), the SNMP Manager IP address (for
the SNMP channel).

Event channel: Defines how the Event Manager
sends an event message. An event channel is one
of: HISTORY (the message is logged in a history

file), EMAIL (the message is sent to an e–mail
address), WEB (the message is stored for analysis
from the PAM web user interface), SNMP (the
message is sent as an SNMP trap to the selected
SNMP application).

Event filter: A list of selected messages among all
possible event messages. If an event message is
not included in the filter, the Event Manager
discards the message.

Event Manager: A PAM feature used to forward

event messages over a configured event channel.
See Event.

Event message: A message sent by a software
component to the Event Manager for routing to a
destination that is configured by an administrator.

Event subscription: An object that defines the
event channel, address, and filter for sending an
event message. If no such object is defined, the
event message is discarded.

F
Fail–over: Failover is a backup operational mode
in which the functions of a system component

(such as a processor, server, network, or database,
for example) are assumed by secondary system
components when the primary component
becomes unavailable through either failure or
scheduled down time.

FAME: Flexible Architecture for Multiple
Environments.

FAST WIDE: A standard 16–bit SCSI interface
providing synchronous data transfers of up to 10
MHz, with a transfer speed of 20M bytes per

second.

FC: Fibre Channel.

FCAL: Fibre Channel Arbitrated Loop.

FCA: Fibre Channel Adapter.

FCBQ: Fan Control Board for QBB.

FCBS: Fan Control Board for SPS.

FDA: Fibre Disk Array.

FDD: Floppy Disk Drive.

Flash EPROM: Flash Erasable Programmable
Read-Only Memory. A type of memory device that
is used to store the the system firmware code. This
code can be replaced by an updated code from a
floppy disk, but is not lost when the computer is
powered off.

Firewall:  A set of related programs, located at a
network gateway server, that protects the

resources of a private network from users from
other networks.

Firmware:  an ordered set of instructions and data
stored to be functionally independent of main
storage.

Format: The process used to organize a hard or
floppy disk into sectors so that it can accept data.
Formatting destroys all previous data on the disk.

FPB: FAME Power Board (FAME: Flexible
Architecture for Multiple Environments).
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FPGA: Field Programmable Gate Array. A gate
array that can reprogrammed at run time.

FRB: Fault Resilient Boot. A server management
feature. FRB attempts to boot a system using the
alternate processor or DIMM.

FRU: Field Replaceable Unit. A component that is
replaced or added by Customer Service Engineers

as a single entity.

FSS: FAME Scalability Switch. Each CSS Module
is equipped with 2 Scalability Port Switches
providing high speed bi–directional links between
server components. See SPS.

FTP: File Transfer Protocol. A standard Internet
protocol: the simplest way of exchanging files
between computers on the Internet. FTP is an
application protocol that uses Internet TCP/IP
protocols. FTP is commonly used to transfer Web

page files from their creator to the computer that
acts as their server for everyone on the Internet. It
is also commonly used to download programs and
other files from other servers.

FWH: FirmWare Hub.

G
GB: GigaByte: 1,073,741,824 bytes. See Byte.

GUI: Graphical User Interface.

GTS: Global Telecontrol Server.

H
HA: High Availability. Refers to a system or
component that is continuously operational for a
desirably long length of time.

HA CMP: High Availability Clustered
MultiProcessing.

Hard Disk Drive: HDD. See Disk Drive.

Hardware: The physical parts of a system,
including the keyboard, monitor, disk drives, cables
and circuit cards.

Hardware Monitor:  A PAM feature used to
supervise server operation.

HBA: Host Bus Adapter.

HDD: Hard Disk Drive. See Disk Drive.

History File: A file in which the History Manager

logs informative messages or error messages
relating to system activity. Messages are sent from
source components to target components.

History Manager: The component running on the
PAP Windows operating system that logs
messages to history files.

HPB: Hot Plug Board. This board provides an
interlock switch on each IO Box PCI slot for hot–
swapping PCI boards. See P–HPB.

HPC: High Performance Computing.

Hot plugging: The operation of adding a

component without interrupting system activity.

Hot swapping: The operation of removing and
replacing a faulty component without interrupting
system activity.

HTTP:  HyperText Transfer Protocol. In the World
Wide Web, a protocol that facilitates the transfer of
hypertext–based files between local and remote
systems.

HW Identifier: Number (0 – F) used to identify
Cellblock components. This number is identical to
PMB code–wheel position.

I
I2C: Intra Integrated Circuit. The I2C (Inter–IC) bus
is a bi–directional two–wire serial bus that provides

a communication link between integrated circuits
(ICs).
The I2C bus supports 7–bit and 10–bit address
space devices and devices that operate under
different voltages.

IA64: is a 64–bit Intel processor Architecture based
on Explicitly Parallel Instruction Computing (EPIC).
The Itanium processor is the first in the Intel line of
IA–64 processors.

IB: Infini Band.

IC: Integrated Circuit. An electronic device that

contains miniaturized circuitry. See Chip.

ICH4: I/O Control Hub.

ICMB: Intelligent Chassis Management Bus.

ID: A number which uniquely identifies a device on
a bus.

IDE: Integrated Drive Electronics. A type of hard
disk drive with the control circuitry located inside
the disk drive rather than on a drive controller card.

Identity: See Domain Identity.
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IIS: Internet Information Server. A group of Internet
servers (including a Web or HTTP server and a
FTP server) with additional capabilities for
Microsoft)  Windows)  NT and Microsoft Windows
(and later) operating systems.

I/O: Input /Output. Describes any operation,
program, or device that transfers data to or from a

computer.

Interface: A connection between a computer and a
peripheral device enabling the exchange of data.
See Parallel Port and Serial Port.

IOB: Input / Output Board. The IOB connects up to
11 PCI–X boards.

IOC: Input / Output Board Compact. The IOC
connects up to 6 PCI–X boards.

IOL: I/O Board Legacy. The IOL provides:
– I/O controller Hub
– USB ports

– 10/100/1000 Ethernet controller
– Video controller
– Serial / debug port

IOR: I/O Board Riser. The IOR provides:
– I/O controller Hub
– USB ports
– 10/100/1000 Ethernet controller
– Video controller
– Serial / debug port

IP: Internet Protocol. The protocol by which data is

sent from one computer to another via the Internet.
Each computer (known as a host) on the Internet
has at least one IP address that uniquely identifies
it from all other computers on the Internet.

IPD: Internal Peripheral Drawer. The IPD houses
legacy peripherals (DVD–Rom drive, USB port)
and SCSI system disks.

IPF: Itanium Processor Family.

IPL:  Initial Program Load. It defines the firmware
functional phases during the system initialization.

IPMB: Intelligent Platform Management Bus.

IPMI: Intelligent Platform Management Interface.

ISA: Industry Standard Architecture. An industry
standard for computers and circuit cards that

transfer 16 bits of data at a time.

J
Jumper: A small electrical connector used for

configuration on computer hardware.

K
KVM: Keyboard Video Monitor.

KVM switch: the Keyboard Video Monitor switch
allows the use of a single keyboard, monitor and

mouse for more than one module.

L
LAN: Local Area Network. A group of computers

linked together within a limited area to exchange
data.

LD: Logical Disk. A Storeway FDA 1300/2300
logical disk (or LUN) is visible to the OS as a Disk.
See LUN and PD (Physical Disk).

LED: Light Emitting Diode. A small electronic
device that glows when current flows through it.

Legacy Application: An application in which a
company or organization has already invested
considerable time and money. Typically, legacy
applications are database management systems

(DBMSs) running on mainframes or minicomputers.

LPT1 or LPT2: The name assigned to a parallel
port to specify its address. See Parallel Port.

LS240: Laser Servo super diskette holding up to
240 Mb.

LUN: Logical Unit Number. Term used to designate
Logical Storage Units (logical disks) defined
through the configuration of physical disks stored in
a mass storage cabinet.

LVDS: Low Voltage Differential SCSI.

M
MAESTRO: Machine Administration Embedded
Software Real Time Oriented. 
Part of the PAM software package embedded on
the PMB board.

MCA: Machine Check Abort.

Memory: Computer circuitry that stores data and
programs. See RAM and ROM.

Memory bank: The minimum quantity of memory
used by the system. It physically consists of four
memory DIMMs.
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MFL: Midplane Fan & Logistics board. The MFL
houses the Fan Boxes and is connected to the MIO
and MQB. See MIO, MQB.

Microprocessor: An integrated circuit that
processes data and controls basic computer
functions.

Midplane: Mid–Plane. All system hardware

components are connected to the Midplane.

MIMD: Multiple Instruction Multiple Data

MIO: Midplane Input / Output board. The MIO
connects one or two IOC boards and the PMB. See
Core Unit.

Mirrored volumes: A mirrored volume is a
fault–tolerant volume that duplicates your data on
two physical disks. If one of the physical disks fails,
the data on the failed disk becomes unavailable,
but the system continues to operate using the
unaffected disk.

Module: a Midplane Board with all its connected

components and utility devices. See CSS Module
and MP.

MQB: Midplane QBB board. The MQB connects
one or two QBBs and one or two IPDs. See QBB
and IPD.

MSX: Midplane SPS & XPS board. The MSX
houses a B–SPS switch and is connected to the
MIO and the MQB. There are two MSX boards in a
CSS module. All SP connections between a QBB
and an IOC use an MSX. See B–SPS, MIO, MQB.

MTBF: Mean Time Between Failure. An indicator

of expected system reliability calculated on a
statistical basis from the known failure rates of
various components of the system. Note: MTBF is
usually expressed in hours.

Multimedia: Information presented through more
than one type of media. On computer systems, this
media includes sound, graphics, animation and
text.

Multitasking: The ability to perform several tasks
simultaneously. Multitasking allows you to run

multiple applications at the same time and
exchange information among them.

N
NFS: Network File System. A proprietary
distributed file system that is widely used by
TCP/IP vendors. Note: NFS allows different
computer systems to share files, and uses user
datagram protocol (UDP) for data transfer.

NMI: Non–Maskable Interrupt.

NUMA: Non Uniform Memory Access. A method of
configuring a cluster of microprocessors in a
multiprocessing system so that they can share
memory locally, improving performance and the
ability of the system to be expanded.

nsh: nsh stands for new shell. See Shell and EFI
Shell.

NVRAM:  Non Volatile Random Access Memory. A
type of RAM that retains its contents even when
the computer is powered off. See RAM and SRAM.

O
OF:  Open Firmware. Firmware controlling a
computer prior to the Operating System.

Operating System: See OS.

OS: Operating System. The software which
manages computer resources and provides the
operating environment for application programs.

P
PAL: Processor Abstraction Layer. See SAL.

PAM: Platform Administration & Maintenance.

PAM software: Platform Administration &
Maintenance software. One part (PAP application
and the PamSite WEB site) runs on the PAP unit.
The other part (MAESTRO) is embedded on the
PMB board.

PAM Tree pane: One of the three areas of the

PAM web page. Server hardware presence and
functional status are displayed in the PAM Tree
pane. See Status pane and Control pane.

PAP unit: Platform Administration Processor unit.
The PC hosting all server administration software.

PAP application: Platform Administration
Processor application. Part of PAM software, PAP
application is a Windows COM+ application
running on PAP unit.

Parallel Port: Connector allowing the transfer of
data between the computer and a parallel device.

PARM request:  the PARM application is designed

to handle Requests issued by the CSE (Customer
Service Engineer)

Partition: Division of storage space on a hard disk
into separate areas so that the operating system
treats them as separate disk drives.

Password: A security feature that prevents an
unauthorized user from operating the system.
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PCI: Peripheral Component Interconnect. Bus
architecture supporting high-performance
peripherals.

PD: Physical Disk. A Storeway FDA 1300/2300
physical disk is not visible to the OS. See LD.

PDU: Power Distribution Unit. Power bus used for
the connection of peripheral system components.

Permanence: Property of a history file that

determines whether or not the history file can be
modified or deleted from the PAM user interface.
Permanence is either Static (cannot be modified) or
Dynamic (can be modified).

P–HPB: PCI Hot Plug Board. This board provides
an interlock switch on each IO Box PCI slot for
hot–swapping PCI boards. See HPB.

PIC: Platform Instrumentation Control.

ping: A basic Internet program that lets you verify
that a particular IP address exists and can accept
requests. The verb “to ping” means the act of using

the ping utility or command.

PIROM: Processor Information ROM. Processor
Information ROM (PIROM) contains information
about the specific processor in which it resides.
This information includes robust addressing
headers to allow for flexible programming and
forward compatibility, core and L2 cache electrical
specifications, processor part and S–spec
numbers, and a 64–bit processor number.

PMB: Platform Management Board. Links the

server to the PAP unit.

PNP: Plug aNd Play. The ability to plug a device
into a computer and have the computer recognize
that the device is there.

POST: Power On Self Test. When power is turned
on, POST (Power–On Self–Test) is the diagnostic
testing sequence (or “starting program”) that a
computer runs to determine if hardware is working
correctly.

PROM: Programmable Read-Only Memory.

PUID:  PAM Universal/Unique IDentifier. PAM
software allocates a PUID (PAM Universal / Unique

Identifier) to each hardware / software object to
guarantee unambiguous identification. 
The PUID for each hardware element can be
obtained by hovering the mouse over the
corresponding element in the PAM tree,  e.g.:
PAM:/CELLSBLOCK_<NAME>/MODULE_x/QBB_
y/CPU_y.

Q
QBB: Quad Brick Board. The QBB is the heart of
the Bull NovaScale Server, housing 4 Itanium � 2

processors and 16 DIMMs. Each QBB
communicates with other CSS Module components
via 2 high–speed bidirectional Scalability Port
Switches. 
See SPS or FSS.

R
RAID: Redundant Array of Independent Disks. A
method of combining hard disk drives into one
logical storage unit for disk-fault tolerance.

RAM: Random Access Memory. A temporary
storage area for data and programs. This type of
memory must be periodically refreshed to maintain

valid data and is lost when the computer is
powered off. See NVRAM and SRAM.

RAS: Reliability, Availability, Serviceability.

Real–time clock: The Integrated Circuit in a
computer that maintains the time and date.

RFI: Radio Frequency Interference.

RJ45: 8–contact regular jack.

RMC: Remote Maintenance Console.

ROM: Read-Only Memory. A type of memory
device that is used to store the system BIOS code.
This code cannot be altered and is not lost when
the computer is powered off. See BIOS, EPROM
and Flash EPROM.

RS-232 Port: An industry standard serial port. See

Serial Port.

RSF: Remote Service Facilities.

RTC: Real Time Clock.

S
S@N.IT: SAN Administration Tool.

SAL: System Abstraction Layer. See PAL.

SAN: Storage Area Network. A high–speed

special–purpose network that interconnects
different kinds of data storage devices with
associated data servers on behalf of a larger
network of users.



Installation GuideG-8

SAPIC: Streamlined Advanced Programmable
Interrupt Controller message.

SBE: Single Bit Error.

Scheme: Configuration file ensuring optimum use
and compatibility of the physical and logical
resources used to simultaneously run multiple
domains.

SCI: Scalable Coherent Interface.

SCSI: Small Computer System Interface. An input

and output bus that provides a standard interface
used to connect peripherals such as disks or tape
drives in a daisy chain.

SDR: Sensor Data Record.

SDRAM: Synchronous Dynamic Random Access
Memory. A type of DRAM that runs at faster clock
speeds than conventional memory. See DRAM.

SEL: System Event Log. A record of system
management events. The information stored
includes the name of the event, the date and time
the event occurred and event data. Event data may

include POST error codes that reflect hardware
errors or software conflicts within the system.

Serial Communication: Data sent sequentially,
one bit at a time.

Serial Port: Connector that allows the transfer of
data between the computer and a serial device.
See COM1 or COM 2.Shell is a Unix term for the
interactive user interface with an operating system.

SIO: Server I/O / Super I/O.

Shell: The Shell is the layer of programming that
understands and executes the commands a user
enters. As the outer layer of an operating system,

the Shell can be contrasted with the kernel, the
inmost layer or core of services of an operating
system. See EFI Shell.

SIOH: Server I/O Hub.

SMBIOS: System Management BIOS.

SM–BUS: System Management Bus.

SMIC: Server Management Interface Chip.

SMP: Symmetrical Multi Processor. The processing
of programs by multiple processors that share a
common operating system and memory.

SNC: Scalable Node Controller.

SNM: System Network Module.

SNMP: Simple Network Management Protocol.
The protocol governing network management and
the  monitoring of network devices and their
functions.

Source: Each message refers to a source (the
resource that generated the message) and a target
(the component referred to in the message). This

feature can be allows messages to be filtered
according to one or more Source string(s) and is
particularly useful for debugging and
troubleshooting. See Target.

SPS: Scalability Port Switch. Each CSS Module is
equipped with 2 Scalability Port Switches providing
high speed bi–directional links between system
components. See FSS.

SRAM: Static RAM.  A temporary storage area for
data and programs. This type of memory does not

need to be refreshed, but is lost when the system is
powered off. See NVRAM and RAM.

SSI: Server System Infrastructure.

Status Pane: One of the three areas of the PAM
web page. Provides quick access to CSS Module
availability status, server functional status, and
pending event message information. See also
Control pane and PAM Tree pane.

SVGA: Super Video Graphics Array.

T
Target:  Each message refers to a target (the
component referred to in the message), identified
by its PUID, and a source (the component that
generated the message).This feature allows

messages to be filtered according to one or more
Target string(s) and is particularly useful for
debugging and troubleshooting. See Source and
PUID.

TCP: Transmission Control Protocol. A set of rules
(protocol) used along with the Internet Protocol (IP)
to send data in the form of message units between
computers over the Internet.

TCP/IP: Transmission Control Protocol / Internet
Protocol. The basic communication language or

protocol of the Internet.

T&D: Tests and Diagnostics.
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Thresholding: A PAM Event filter criterion.
Thresholding is defined on a Count / Time basis
aimed at routing significant messages only.
Identical messages are counted and when the
number of messages indicated in the Count field is
reached within the period of time indicated in the

Time field, this message is selected for routing.

U
UART: a Universal Asynchronous Receiver

Transmitter. The microchip with programming that
controls a computer interface to its attached serial
devices.

ULTRA SCSI: An enhanced standard 16–bit SCSI
interface providing synchronous data transfers of
up to 20 MHz, with a transfer speed of 40M bytes
per second. It is also called Fast-20 SCSI.

UML: Unified Modeling Language. A standard
notation for the modeling of real–world objects as a
first step in developing an object–oriented design

methodology.

UPS: Uninterruptible Power Supply. A device that
allows uninterrupted operation if the primary power
source is lost. It also provides protection from
power surges.

URL: Uniform / Universal Resource Locator. The
address of a file (resource) accessible on the
Internet.

USB: Universal Serial Bus. A plug–and–play
interface between a computer and add–on devices.
The USB interface allows a new device to be

added to your computer without having to add an
adapter card or even having to turn the computer
off.

V
VCC: Voltage Continuous Current.

VGA: Video Graphics Array.

VI: Virtual Interface.

Visibility: A property of a history file. Visibility is
either System (the history file is predefined by the
PAM software and is visible only to an
administrator) or User (the history file is created by
an administrator and is visible to both an
administrator and an operator).

VLAN: Virtual Local Area Network. A local area

network with a definition that maps workstations on
some other basis than geographic location (for
example, by department, type of user, or primary
application).

VxWORKS: Platform Management Board
Operating System.

W
WAN: Wide Area Network. Geographically
dispersed telecommunications network. The term
distinguishes a broader telecommunication
structure from a local area network (LAN).

WBEM: Web Based Enterprise Management.

WMI: Windows Management Interface.

WOL: A feature that provides the ability to remotely

power on a system through a network connection.

X
XML: eXtended MarkUp Language. A flexible way
to create common information formats and share

both the format and the data on the World Wide
Web, intranets, and elsewhere.

XSP: eXtended Scalable Port.

Y
No entries.

Z
No entries.
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Index

Numbers
16–port KVM Switch, data cables, C-23
8–Port KVM Switch, data cables, C-4

A
Access, front door, 2-2
Autocalls

configuring, 2-32
FTP parameters, 2-32
testing, 2-52

B
Back Up, PAM software, 2-63

C
Cabinet

front door, 1-24
packing, 1-9
rear door, 1-25
refitting front door, 1-24
refitting rear door, 1-25
refitting side covers, 1-26
removing front door, 1-12
removing rear door, 1-13
removing side cover, 1-14
shipping brackets, 1-16

Cabinet packing, removing, 1-10
Cables, labels, 2-9
Cabling, inter–cabinet, 2-9
CD drive, troubleshooting, 3-9
CD–ROM drive, 1-33

accessing, 2-6
Central Subsystem

configuring, 2-53
removing, 2-53

Central subsystem, adding, 2-53
Checks

autocall connection, 2-52
network connections, 2-52
server operation, 2-15
server status, 2-18

Components
6080, 1-27
6320, 1-29
6160, 1-28

Connecting, external devices, 2-51
Connections

Enterprise LAN, 2-35, 2-50
network, 2-52
PAP unit, 2-35

Console, 1-34
data cables, C-3, C-21
opening / closing, 2-3
setting up, 2-4
toggling, 2-20

Console drawer, closing, 2-5
CSS Module, PMB, 2-7

CSS module, 1-31
availability status, 2-18
shipping brackets, 1-22

Customer information, configuring, 2-31

D
Data cables

 integrated console, C-3
16–port KVM Switch, C-23
8–port KVM Switch, C-4
console, C-21
Ethernet hub, C-17, C-36
FDA 1300 FC disk rack, C-12
FDA 1300 FC extension disk rack, C-13, C-32
FDA 2300 FC disk rack, C-14
FDA 2300 FC extension disk rack, C-15, C-34
IOR, C-6
IOR (KVM AV1000R), C-25
PAP unit, C-8, C-26
PMB, C-16, C-35
SJ–0812 disk rack, C-28
SJ–0812 SCSI disk rack, C-10
SR–0812 disk rack, C-29
SR–0812 SCSI disk rack, C-11
Storeway FDA 1300 disk rack, C-31
Storeway FDA 2300 disk rack, C-33

Delivery
server, 1-7
system, 1-2

Details pane, PAM, 2-19
Devices, external, 2-51
DIMMs, 1-31
Disk Rack, troubleshooting, 3-8
Disk racks, setup, 2-48
Diskette drive, accessing, 2-6
Disks, 1-33, 1-36, 1-38
Domain

power down, 2-21
power up, 2-21

DVD/CD–ROM drive, 1-31

E
Electrical safety, xi
Electromagnetic compatibility, xiii
Electrostatic discharges, xiii
Enterprise LAN

connecting PAP unit, 2-35
connection, 2-50

Environmental standards, xiii
Ethernet hub, 1-41

data cables, C-17, C-36
Ethernet ports, 1-31, 1-33

F
FC storage subystems, password, changing, 2-34
FDA 1300 disk rack, 1-38
FDA 1300 FC Disk rack, data cables, C-12
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FDA 1300 FC extension Disk rack, data cables,
C-13, C-32

FDA 2300 FC Disk rack, data cables, C-14
FDA 2300 FC disk rack, 1-39
FDA 2300 FC extension Disk rack, data cables,

C-15, C-34
FDD, 1-33
Features, system, A-1
Front door

opening, 2-2
removing, 1-12

G
Getting to know, server, 1-27

I
Illegal characters, B-4
Inspecting

cabinet packing, 1-9
server, 1-11

Inspection
cabling, 1-23
components, 1-23

Installation
flowchart, xvi
intervention report, 2-52

Intervention report, installation, 2-52
IOB, 1-31, 1-32
IOR, 1-31

data cables, C-6
IOR (16–port KVM Switch), data cables, C-25

K
Keyboard, 1-34

troubleshooting, 3-4
Keys, registry, B-5
KVM switch, 1-35

troubleshooting, 3-6

L
Labels

shockwatch, 1-9
tiltwatch, 1-9

Laser safety, xii
Limits

audio–noise, xv
pollution, xv

LS240 drive, 1-31

M
Memory boards, 1-31
Modem, 1-41
Monitor, 1-34

troubleshooting, 3-5
Mother boards, 1-31
Mouse, 1-34

troubleshooting, 3-3
MPI, 1-31, 1-32

N
Network, testing, 2-52

Notices
electrical safety, xi
laser safety, xii
safety, xi

O
Operating System

completing setup, 2-38
troubleshooting, 3-10

Operating system, setup
completing, 2-39, 2-43
Microsoft Windows, 2-40, 2-44

P
Packing items, storing, 1-18
PAM

details pane, 2-19
status pane, 2-18
toolbar, 2-19
user interface, 2-17
writing rules, B-4

PAM software
back up / restore, 2-63
launching, 2-15
troubleshooting, 3-11

PAM tree pane, 2-19
PAP, troubleshooting, 3-7
PAP unit, 1-33

CD–ROM drive, 1-33
configuration, 2-29
data cables, C-8, C-26
diskette drive, 2-6
disks, 1-33
DVD–CD Rom drive, 2-6
Ethernet ports, 1-33
FDD, 1-33
serial ports, 1-33

PAP users, setting up, 2-61
Password, changing, FC storage subsystems, 2-34
PDU, 1-42
PHPB, 1-31
PMB, 1-31, 1-32

code wheels, 2-7
data cables, C-16, C-35

Power cables, 1-33, 1-34, 1-35, 1-36, 1-37, 1-38,
1-39, 1-40, 1-42

PDU, 2-13
sockets, 2-11

Power down, server domain, 2-21
Power supply, connecting, 2-14
Power supply cables, server, C-19, C-38
Power–up

server, 2-14
server domain, 2-21
system domains, 2-25

Processors, 1-31
Program, post–install, 2-29
PUID, PAM software, 2-15

Q
QBB fan boxes, 1-31, 1-32
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QBBs, 1-31, 1-32

R
RAID controller, 1-36
Rail / Ramp assembly, installing, 1-15
Rear door, removing, 1-13
Remote access

iSM, 2-37
PAM, 2-36

Restarting, server, 2-24, 2-28
Restoring, PAM software, 2-63

S
Safety

notices, xi
recommendations, 2-14
specifications, xv

SCSI HBA, 1-31
SCSI JBOD rack, 1-36, 1-37
SCSI rack, 1-36
Serial ports, 1-31, 1-33
Server

configuring, 2-53
domain, 2-21
getting to know, 1-27
inspecting, 1-11
power supply cables, C-19, C-38
restarting, 2-24, 2-28
shutdown, 2-24, 2-28
unloading, 1-12
unpacking, 1-8

Server cabinet
installing, 1-19
securing, 1-19

Server components
accessing, 2-2
CD–ROM drive, 1-33
console, 1-34
CSS module, 1-31
DIMMs, 1-31
disks, 1-36, 1-38
Ethernet hub, 1-41
Ethernet ports, 1-31, 1-33
FDA 1300 FC, 1-38
FDA 2300 FC, 1-39
FDD, 1-33
IOB, 1-31, 1-32
IOR, 1-31
keyboard, 1-34
KVM switch, 1-35
LS240 drive, 1-31
memory boards, 1-31
Midplane, 1-31, 1-32
modem, 1-41
monitor, 1-34
mother boards, 1-31
mouse, 1-34
PAP unit, 1-33
PAP unit disks, 1-33
PDU, 1-42
PDU power cable, 2-13
PHPB, 1-31
PMB, 1-31, 2-7

power cables, 1-33, 1-34, 1-35, 1-36, 1-37,
1-38, 1-39, 1-40, 1-42, 2-11

processors, 1-31
QBB fan boxes, 1-31, 1-32
QBBs, 1-31, 1-32
RAID controller, 1-36
SCSI HBA, 1-31
SCSI JBOD rack, 1-36, 1-37
SCSI rack, 1-36
serial ports, 1-31, 1-33
SPS fan boxes, 1-31, 1-32
USB ports, 1-31
VGA port, 1-31

Server operation, checking, 2-15
Server power, troubleshooting, 3-2
Server status, checking, 2-18
Setting up

console, 2-4
PAP users, 2-61

Setup
Microsoft Windows, 2-40, 2-44
operating system, completing, 2-39, 2-43
preparing disk racks, 2-48

Shipping brackets
cabinet, 1-16
CSS module, 1-22

Shocks and vibrations, xiv
Shockwatch, labels, 1-9
Shutdown, server, 2-24, 2-28
Side covers

refitting, 1-26
removing, 1-14

SJ–0812 disk rack, data cables, C-28
SJ–0812 SCSI disk rack, data cables, C-10
Specifications

atmospheric, xiii
electrical, xiii
NovaScale 6080/6160 Servers, A-1
NovaScale 6320 Servers, A-3
safety, xv
system, A-1

SPS fan boxes, 1-31, 1-32
SR–0812 disk rack, data cables, C-29
SR–0812 SCSI disk rack, data cables, C-11
Status, CSS module, 2-18
Status pane, PAM, 2-18
Storeway FDA 1300 Disk rack, data cables, C-31
Storeway FDA 2300 Disk rack, data cables, C-33
Storing, packing items, 1-18
String lengths, B-4
System

dimensions, A-1
domains, 2-25
weight, A-1

System components, DVD/CD–ROM drive, 1-31

T
Tiltwatch, labels, 1-9
Toolbar, PAM, 2-19
Troubleshooting, 3-1

CD drive, 3-9
disk rack, 3-8
keyboard, 3-4
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KVM switch, 3-6
monitor, 3-5
mouse, 3-3
Operating System, 3-10
PAM software, 3-11
PAP, 3-7
server power, 3-2

U
Unloading

rail / ramp assembly, 1-15
server, 1-12

Unpacking, server, 1-8

USB modem, connecting, 2-51
USB ports, 1-31
User group, PAP, 2-61
User interface, PAM, 2-17

V
VGA port, 1-31

W
Writing rules

illegal characters, B-4
string lengths, B-4
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